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1. Giris.
Maglumat bazalary dolandyryjy ulgamlar.

Bizin Baky Bitarap  Garagsyz  Tirkmenistan
dowletimizde ylym we bilim in o6ndebaryjy ugurlar bolup
duryarlar. Ylym we terbiye bermek mugallymyn wajyp
borjydyr. Ylymy 6wrenmek, onia 6z gosandyily gosmak her bir
okuwcydyr-talybyn borjydyr. Halkymyz bilen hemise bir jan —
bir ten bolup, gije-giindiz berkarar dowletimizii we onun
bagtyyar rayatlarynyn aladasyny edyidn hormatly Prezidentimiz
Gurbanguly Berdimuhamedow yurdumyzy 6stislerden-ostislere
alyp baryar. Tutumly islerin hatarynda dowlet Bastutanymyzyn
halkymyzyii ruhy Osiisine, ahlak taydan k&dmillesmegine, ata-
babalarymyzyn bay edebi, medeni mirasyny gorap saklamaga,
milli medeniyetimiziii, sungatymyzyn gadymy koklerini
gaytadan dikeltmige, 0sdiirmdge we dowriimizin ruhy bilen
baylagdyrmaga tarap alyp baryan ugry ayratyn mohiim
dhmiyete eyedir. Sol beyik islere mynasyp gosant gosmak
bolsa biz yaglaryn mukaddes borjy bolup duryar. Milli
Liderimiz yaslara hemise howandarlyk edyir. Yagny, bizi
yokary derejede howeslendirip, tdze doredijilik gozleglerine,
hiindr ussatlygyna ruhlandyryar. Hézirki wagtda yaslaryn
kamillige yetmegi ticin gifi miimkingilikler bar. Yurdumyzy
ahli edara-kédrhanalarynda, okuw mekdeplerinde in héazirki
zaman  tehnologiyalary = we  kompyuter  tehnikalary
ornagdyrylyp, isler ylmy esaslarda yola goyulyar. Hormatly
Prezidentimiz Gurbanguly Berdimuhamedowyn
bastutanlygynda ata Watanymyzyn gazanyan istiinlikleri onun
Beyik Galkynysyil sayolundan ynamly oOne baryandygynyn
subutnamasydyr. Hormatly Prezidentimiz milli kanungylygyn
dowrebaplasdyrylmagyna, durmus we senagat
infrastrukturasyny Osdiirmidge uly iins berydr. yurdumyzy
ykdysady, durmus we medeni taydan 6sdiirmek boyunga alnyp
barylyan gin mogberli islerde bilime berilydn dhmiyet ordn
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ulydyr. Yurt Bastutanymyz “Dowlet adam iicindir!” diyen
sygary One siirmek bilen, yas nesil hakyndaky alada dowlet
isinil mohiim ugry hokmiinde garayar. Ahlihalk tarapyndan
biragyzdan Prezident saylanandan soni Tiirkmenistanda bilim
ulgamyny kémillesdirmek we bu isi diinyadnin Osen
dowletlerinin derejesine yetirmek maksady bilen hormatly
Prezidentimizin gol c¢eken ilkinji Permanlarynyn birinin
“Tlirkmenistanda bilim ulgamyny kamillesdirmek hakynda”
bolmagy-da muny tassyklayar. Beyik Galkynys eyyamynda
tiirkmen bilimini 6sdiirmek boyunca yiizyyllyklara barabar is
edildi. Muna tiirkmen Diyarynda Beyik Galkynys eyyamynda
yurdumyzyn tdze belentliklere tarap ilerlemeginiii esasy
stitiinlerinii biri bolan bilim ulgamyny diinyd {lielerine
layyklykda  guramak,  ylmy-tehniki  Osiisin =~ dowlet
maksatnamalaryny yzygiderli we netijeli durmusa gegirmek
maksady bilen alnyp barylyan isleride giiwid gecyér.

Informasion ulgam — bu c¢ylsyrymly maglumatlaryn
istnde isleydn, yatda saklayan we ulanyja k&mil, amatly
interfeysi  hodiirleydn  programma  kompleksidir.  Fayl
ulgamlardan tapawutlylykda informasion ulgamlar asakdaky
miimkingilikleri hodiirleyar:

- hasabat yoretmek we maglumatlary dikeltmek;

- maglumatlar bilen kdpulanyjyly is rezimi,

- maglumat saklamagyn ygtybarlygy, olaryin goragy we
yiizlenmelerinn kontroly;

Héazirki dowrtin maglumat bazalary dolandyryjy
ulgamlarylary ¢ylsyrymly dolandyrylyan obyektin dinamiki
informasion modelini goldap bilyédnligi sebépli, informasion —
habar beriji programma ulgamlary gorniisinde ¢ykys edyir,
yagny bu yerde maglumatlary girizmek, tidzelemek, lstiinde
islemek we kopgilikleyin el yetirmegi iipjiin edydr. Sol bir
informasiyany ulanyp, diirli ulanyjylar kyngylyksyz diirli
meselelerini yazyp bilyirler.

10



Visual Foxpro-dan oniirti informasiya saklamagyn
esasy strukturasy hokmiinde maglumat bazalary ya-da dbf —
fayllar ¢ykys edipdir.

Hézirki dowiirde maglumat bazalar hokmiinde
tablisalar, indeksler, proseduralar we funksiyalar, birikdirilen
tablisalar ¢ykys edyarler.

Visual Foxpro atly maglumat bazalary dolandyryjy
ulgamda doredip bolyan we ulanyp Dbolyan esasy
komponentlerin edyén isinii gorniislerini, su komponentlere
degisli fayllaryn standart gineldilmeleri asakda getireliii:

- Tablisa. Maglumat bazalary dolandyryjy ulgamda in
esasy komponenti hokmiinde ¢ykys edyédr. Diirli
informasiyany saklamaga niyetlenen.

ADY Doglan wagty Gosmaca
Atayew 01/01/98 MEMO

Surat 1:Tablisanyn Memo meydany.

Yokardaky suratda gorkezilen “Gosmaca” atly siitiinde
“memo” tipi kesgitlenen, yagny islendik uly tekstleri,
reklamalary,petekleri yerlesdirip bolyar.

Kompyuter tehnikasy
Tiirkmen Politehniki instituty

Salgy: 744028, tel: 41-18-25

Surat 2: Emblema

- Klawiaturanyn makroslary.
Tekst informasiya bilen isi tizlesdirmek ii¢in ulanylyar.

- Indeks fayllary.
Bir ndge tablisalaryn arasyndaky arabaglanysyk we
maglumatlaryn gozlegini caltlagdyrmak tgin niyetlenen.

- Berlenleri gorkezyin fayl.
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Belli bir pursatda agyk maglumat bazalaryn, tablisalaryn,
indekslerin, tablisalara arabaglanysyklaryn
informasiyalaryny saklayar.

Maglumat bazasy.

Bir nice indeksli tablisalary, lokal we das aralykdaky
berlenleri birikdiryar.

Programma fayllary.

Tayyar priloZeniyanyn ahli elementlerinin
dolandyrylysynynn we dialog gurnamagyn kodlaryny
saklayar.

Menyu.

Maglumatlaryn listiinde islemegin usullaryny
saylamaklygyn miimkingiligi.

Hasabat.

Tablisalardan alynan maglumaty hasabata we c¢apa
cykarmak.

Etiketka.

Diirli kartogkalary, biletleri, petekleri doéredip bolyar.
SQL talaplary.

Berlenleri derndp we grafiki informasiyany c¢ykaryp
bolyar.

Taslama.

Ahli programmalary, maglumat bazalary, menyulary,

formalary we beyleki komponentleri birikdiryar.

Visual Foxpro berlenlerin importyny we eksportyny

gecirip, office programmalaryn arasyndaky maglumat alys-
calysy yerine yetirp bolyar.

Maglumat bazalary dolandyryjy ulgamlaryn osiisi
Fayllaryn standart gifieltmeleri:

Diirli fayllar ti¢in standart gineltmeler hodiirlenyar:

+ app prilozeniyanyn fayly;
+ avi wideoklip fayly;
+ bmp surat fayly;
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+ dbc maglumat bazanyn fayly

+ dbf tablisanyn fayly;

+ dbf konfigurasiya fayly;

+ dct maglumat bazanyit memo-fayly;

+ dcx maglumat bazanyn indeks fayly;

* err kompilyasiya yalnyslyklaryn
fayly;

+ esl Visual Foxpro kitaphanasy;

+ exe yerine yetiriji fayl;

+ fky klawiaturanyfi makroslarynyi
fayly;

£ Frx/frt hasabatyn fayly;

+ Htm HTML formatyndaky fayl;

+ ldx indeks fayllary;

+ Log alynan programma kodlaryn
registrasiya fayly;

+ Mnx menyuny diistindiriji fayl;

+ Mpx menyu programmasynyn
kompilyasiyasy;

+ Prx taslamanyn fayly;

+ Prg programma fayly;

+ Qrz SQL talaplaryin programmasy;

£ Txt tekst fayly;

+ Scx ekran formasynyti fayly;

+ Wav ses signalynynyi fayly.

70-nji yyllaryn ahyrynda maglumatlaryn {istlinde
islemegin  gornligini  awtomatlasdyrmak  {icin  yorite
maglumatlary dolandyryjy programmalaryn komegi bilen
maglumat bazalary dolandyryjy ulgamlar doredilyar. Diirli
maglumat  bazalary dolandyryjy ulgamlarda berlenleri
gurnamagyn logiki modelinin iyerarhiki, tor, relyasion
gornligleri  ulanylyar. Iyerarhiki modelinde berlenlerin
arasyndaky baglanysyk grafik gorniisinde getirilip, yokardan
asak hereket etdirydr. Tor modelinde ,biri-kopliige* usuly
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ulanylyar, bu usuly durmusa gegirmek kyn we gymmat bolyar.
Su sebédpli matematiki gatnasygy — ,.relation ulanmak amatly
goriilydr, bu yerde tablisalar we olaryn diiziimi ulanylyandyr.
DBQ, SQL Serwer, Oracle, Informix, Progress atly maglumat
bazalary dolandyryjy ulgamlarda berlenleri gurnamagyn
relyasion modeli ulanylyar. Relyasion modelin kemgiligi :

- husy mogbersiz harglap ulanmak;

- maglumatlaryn istiinde islemegi tablisanyn gOwriimine

bagly bolyar.

Relyasion maglumat bazalary dolandyryjy ulgamlar 6z
gezeginde iki ulgama boliinyér, yagny bir gorniisinde tayyar
programma doly programma kompillyasiyadan gecyér, beyleki
gorniisde bolsa sol programma kanagatlayyn rezimde isleyar.
Bu usulda her komandanyn netijesini deriidp, yaliyslyklary
yenillik bilen tapyp bilyar. Bu yagdayda interpretator
ulanylyar. Interpretirlenyén tipli ulgamlary owrenmek yenil
bolyar. Visual Foxpro maglumat bazalary dolandyryjy
ulgamlaryn iginde ifi yokary tizlikli, ol amatly interfeysli, SQL
dilini goldayan kopulanyjyly we tor rezimde isleydn, internete
cykyp bilyan ulgam hékmiinde ¢ykys edyér. Visual Foxpro-da
programmany ddimleyin yerine yetirtdirydn ululyklaryn we
tablisa meydanlaryl bahalaryny yzarlamaga miimkingilik
berydn yorite penjireler bar. Visual Foxpro WINDOWS
sredasynda isleyér, islendik dil standartlary gurnap bolyar.
Visual Foxpro ulgamynyn instalyasiyasy ii¢in azyndan 8
Mbayt gerek.

2. Visual Foxpro-nyi hodiirleyan miimkingilikleri,
bas penjiresi.

Ulgam ise girizilinde Visual Foxpro-nyn bas menyusy
acylyar. File, Edit, View, Format, Tools, Program, Window,
Help menyulary ulgam menyusyna giryir, F10 diiwme bilen
aktiwlesydr. Komandalary Alt bilen aktiwlesdirip bolyar. File
menyusy Windowsyn standart komandalaryny 6z igine alyar,
gosmaga her komandanyn 6z diitwmeleri bar. Syn :
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SAVE as HTML — HTML dokument hékmiinde agyar.
Import — diirli formatdaky fayllary dbf formata owiiryar.
Export — importyii prosesini yzyna dwiiryar.

Edit menyusy Windows operasion ulgamyndaky bilen
gabat gelyar.

GO TO line — programma derficlende gerekli setirine
baryp bolyar.

View menunyn diiziimi :

Browse/edit — tablisany gormek/redaktirlemek;

Append mode — tablisanyn ahyrynda bos yazgy goyyar;
Table Designer — tablisany we indekslerini goriip bolyar,
strukturasyny tiytgedip bolyar;

Form Controls Toolbar — obyektleri forma yerlesdirmek
ticin gurallar paneli agylyar;

Color Pallette Toolbar — renk palitrasy;

Show Position — saylanan obyektini formada yerlesisini
gorkezydr;

Design (konstruktor) — onden gormek reziminden
konstruktor rezimine gegilyir;

Report Controls Toolbar — hasabatda diirli dolandyrma
elementleri goyup bolyar;

Report Preview Toolbar — hasabaty 6niinden gérmek;
Grid lines — sahypanyn yiiziindaki tory gorkezmek;

Format menyunyn isi saylanan is sredasyna bagly bolyar:

Font (Srift);

Enlarge font (srifti ulaltmak);

Reduce font (srifti kigeltmek);

1v4 space (yarym interwal);

Double space (iki interwal);

Bring to font — saylanan obyekti dhli obyektlerden 6ne
goyyar;

Send to back — saylanan obyekti dhlisinden yza goyyar;
Group — hasabatdaky obyektleri bir topara birikdiryar;
Ungroup — topary ayratyn obyektlere dargadyar;
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= Text Augment — saylanan obyektiil tekstini deneyér;
= Fill — zaliwka(renk bilen dolduryar);
= View white space — probellaryn( bos yerlerinifi) yerini
gorkezyar;
Tools (serwis) menyusy.

Bu menyunyn komandalary diirli gorniisli gurallary
ulanmaga miimkingilik beryér. Ilki bilen Wizard (master-
uusady) tertibi agylyar, gerekli gosmag¢a menyu saylanyar.

Ussat Isi

Table Tablisa doretmek

Query Talaplary doretmek

Form Forma déretmek

Label Etiketkalary, petekleri doretmek
Report Hasabatlary doretmek

Mail merge Birikdirilen hasabatlary doretmek
Pivot table Yoritelesdirilen tablisa doretmek
Import Berlenleri importirlemek
Documenting Taslamany dokumentlesdirmek
Database Maglumat bazany doretmek
Web publishing WEB-sahypany doretmek

Tools menyunyn komandalary:

Macros -

Code Reference
(MoOMCK KOIOB) -

Debugger -

dialog penjiresini ¢agyryar, bu yerde
boljak makrokomandanyn adyny,
lziimini we ulanyljak  diiwmeleri
esgitleyar.

taslamadaky ya-da papkadaky
programma  fragmentleri we  tekst
setirlerin gézlegini iipjiin edyar. overage
Profiler - log gineldilmeli faylda kodlar
saklanylyar.

programma kodlary ise giriziji dialog
penjiresi — bu yerde tablisanyn
16




meydanlaryny, iytgeydn ululyklary,
massiw  elementleri,  funksiyalaryn
netijelerini bilip bolyar.

Options - gatly penjire agylyar, her haysy
ulanylyan kodlar barada maglumat
saklayar. ~ Visual Foxpro-nyn isini
kontrollykda saklap biljek
komandalardan ybarat.

Menyularyn dernelsi
Program menyusy:
Bu menyu diiie programma fayllary bilen isleyar.

Do.. - yerine yetiriljek programmany saylamak ii¢in
dialog penjiresi agylyar.

Cancel - programmanyii isini kesyar.

Resume -  saklanylan programmany isini dikeltyar.

Suspend -  programmany wagtlayyn saklayar.

Help menyusy

Bu menyu komekg¢i hokmiinde ¢ykys edyir. Ulgam menyuny
dikeltmek ti¢in Set sysmenu do default komandany bermeli.

+ Komanda penjiresi :
Command- tiytgedip, birikdirip bolyar :

Arrange all — penjiréni agyar.

Hide — aktiw penjirdni gizleyar.
Command penjirede bir wagtda birnd¢e komandalary yerine
yetirip bolyar.

CTRL+F2 diiwmesi Command penjirdni in yokarsyna
cykaryar.

Visual Foxpro 8.0-dan baslap komandalary doly girizmek

hokmany dal, sebébi bir simwoldan sonra komekgi sozler

gorkezilip baslayar.

Mysal : MODIFY COMMAND yazylsa, asakdan
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PROJECT
QUERY
REPORT yazgysy ¢ykyar.
<aragdk> opsiyasy tablisadaky yazgylarynyin haysysyna
tasir etmelidigini kesgitleyar we asakdaky bahalary alyar:

All — &hli yazgylara tésirli;

Rest — kursoryn duran yerinden
tablisanyn ahyryna cenli;

Next n — kursoryn duran yerinden N sany
yazgy;
Record N — dine N yazgy nomeri yazgynyn

iistiinde isleyar.

Fields <cmucoxk moseir> — opsiyasy tablisadaky gerekli
meydanlaryn atlary kesgitlenyér.

For < > — opsiyasy serte layyk gelydn
yazgylaryn  lstiinde komanda
yerine yetirilyér.

While < > — opsiyasy sert yerine yetyincé
komanda isini dowam etdiryér.

Visual Foxpro komandalaryndaky anlatmalar.

Anlatmalar 6z i¢ine operasiya bellikleri bilen
birikdirilen bir tipli {lytgeydn ululyklary, funksiyalary,
meydanlaryi atlaryny we konstantalary alyp bilydr. Simwol,
san, logiki data we wagt tipli anlatmalar bolup bilydr. San
anlatmalarda +, -, *, /, % - galyndy, ** - derejd gétermek yaly
operasiyalar ulanylyar.
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Not. ya-da !, .AND., .OR,, <, > = (0, I, = #)—den
dil, <= logiki anlatmalarda ulanylyar.
Anlatmalaryi tipi :

Simwol
San
Logiki
Data
General
Memo
Pul
Obyekt
Ekran

WO<XZOUrFzZ0

Data tipli konstantalar figura skobkalarda gorkezilyar:
Mysal: { 2008/09/11} ya-da {09/09/08}
- Logiki konstantalar True (¢yn) we False (yalan) bahalary
kabul edyér, ya-da Y ya-da N.
- San konstantalary bitin ya-da fiksirlenen nokatly bolup
bilyar.
Visual Foxpro-nyn prilozeniyalary bilen isleniljek bolsa,
anlatmalary dogry gurnamak ii¢in Expression Builder dialog
penjiresini ulanmak maslahat berilyar. Bu penjirede isjen
tablisa degisli meydanlarynn sanawy we dort sany menyu
gorkezilyar:
String — setir bilen islemek ti¢in funksiyalar;
Data — ay-giin bilen islemek {i¢in funksiyalar;
Math — sanlar bilen islemek tigin funksiyalar;
Logical — logiki operasiyalar bilen islemek ii¢in
funksiyalar.

3. Visual Foxpro-nyii gurnalysy.
Visual Foxpro ise girizilende awtomatiki is sredasy
gurnalyar, yagny ulgam fayllaryn yerlesisi, penjireler, sriftler,
reiikler we s.m. hédsiyetnamalar kesgitlenilydr. Bu yerde
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hokmany config.frw konfigurasiya fayllary ulanylyar. Is seansy
wagty options dialog penjirani ulanyp, is sredasynyn gorniisini
iytgetmage miimkingilik bar. Visual Foxpro ise girizilende is
papkasynda config.fpw fayly okalyar. Bu tekst fayly, onun her
setiri ulgamyn haysy hem bolsa bir konfigurasiyasyny anladyar
we seyle gorniise eye bolyar: <mapamerp> = <3HaueHHE>
Config.fpw fayly redaktirldp bolyar, onun asakdaky
gurnawlary bar :
START UP =*“ *“ -prilozeniye bilen islenilende baslangyc
programmany kesgitleyar.
SAFETY = OFF -fayl tdzeden yazylanda duydurys berilmeyar.
TALK = OFF -aralykdaky operasiyalaryil netijeleri ekrana
cykarylmayar
COLOR SET = <renkler> -renkleri kesgitleyar.
DEBUG = ON -diizedis girizip bolyan penjirelere rugsat
etdiryar.
Bulardan basga-da config.fpw faylda ululyklary, isleniljek
hasabatlary, formalary, etiketkalary, petekleri, talaplary
kesgitldp bolyar.

Mysal {i¢in : ay-giin maglumaty kesgitlalin:

Data tablisanyn i¢ine diirli formatda girizilip biliner.
Maglumat nddogry girizilse, « invalid input » habary

gorkeziler.
SET DATA AMERICAN ay/giin/yyl;
SET DATA ANSI yyl.ay.giin;
SET DATA JAPAN yyl/ay/giin  we s.m.

SET CENTURE ON bolsa yylyi 4 (2009) sany girizilydr.
SET CENTURE OFF bolsa yylyn 2 (09) sany girizilyar.

Eger ulanyjy bir yerde islejek bolsa, onda katalog
doretmeli bolyar. Bu yerde SET DEFAULT TO komandany
bermeli. Mysal : SET DEFAULT TO C:\MITDAU

Fayllary SET PATH TO <yolyn sanawy>
komandanyn kdmegi bilen gézldp bolyar.
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View atly komek¢i wkladkasynda umumy yagdayyn
setiri, setirddki sagat, bir ndge komandalaryn netijesi, ulgam
habarlary barada gurnawlar bar, olar degislilikde:

SET STATUS BAR ON/OFF;

SET CLOCK ON/OFF;

SET TALK ON/OFF;

SET NOTIRY ON/OFF.

Open last project on startup komandasy in sonky
acylan taslama awtomatiki agyar. General wkladkasynda

birnd¢e komandalar bar :
Warning sound —

Programming -

SET ESCAPE OFF/ON -

maglumatlar girizilende yaliys
goyberilse, ses ya-da SET BELL
ON/OFF signalyny goyberyar.
esasan  programmalar  bilen
islenilende kesgitlenyér, iki sany
komandasy bar.

ESC bilen programmany kesmage
(Yapmaga) rugsat
bermek/gadagan etmek;

SET LOGERRORS OFF/ON —.err gineldilmeli fayla

kompilyasiya dowri  tapylyan
yalityslary yazmak.

Set CARRY ON/OFF- bir yazgynynh maglumatlaryny
tize bos yazga kopiya edip
bolyar.

Data atly wkladkada :

SET EXCLUSIVE ON/OFF - tablisany ya-da bazany
ulanmaklykda  monopol
rezimi;

SET HEADINGS ON/OFF — tablisa gozden gecirilende

meydanlaryil atlaryny bas
harp bilen gorkezyir;

CURRENCY and NUMBERS -  yiizyédn nokatly sanlary we

pul formatyny kesgitleyar.
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SET DECIMALS - onluk sanlaryt sanyny

kesgitleyar.
Remote data atly wkladkalar :
Records to fetch - belli bir wagtda serwerden nége
sany vazgy alyp bolyandygyny
kesgitleyar.

Maximum records to fetch - serwerden gegirilmeli yazgylaryn
maksimal sanyny kesgitleyar.
Connection timeout - serwer bilen baglanysmak ii¢in
bellenilen  wagtyndan  gegse,
yaliiyslyk barada habar berilyér.
Query timeout - kesgitlenen  wagt aralygynda
ulanyjynynn ~ talabyna  serwer
tarapyndan  jogap  berilmese,
yaliiyslyk barada habar berilyér.
Ahli  kesgitlenen gurnawlar baradaky maglumaty
Display Status komandasy hodiirleyar. Mysal :

Prosessor is Pentium

Selected table : table in use D:\Application\MITDAU\
maglumat.dbf
Index file : D:\Application\MITDAU\ maglumat.idx
Data format : American.
4. Tablisalar.

Visual Foxpro-da dhli tablisalar, indeksler, proseduralar
we funksiyalar barada maglumat saklayan topluma
maglumatlar bazasy diyilydr. Birndce tablisa husda .dbf
gifeldilmede saklanyar. Tablisanyn ady 128 simwola cenli
bolup bilydr. Tablisada setirlere yazgy, siitiinlere meydan
diyilydr. Meydanlaryii ady komandalaryn ady bilen gabat
gelmese gowy bolyar. Ahli programma obyektlerii yagny,
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maglumat  bazalaryn, = meydanlaryn,  programmalaryn,
proseduralaryn, funksiyalaryn, massiwlerin atlary islendik
gurnalan dil standartynyn simwollary bilen goyup bolyar.
Tablisanyn her yazgysynyn bir ya-da birnd¢ce meydanlary bar.

Visual Foxpro-da meydanlara hodiirlenyin tipler :

Character islendik simwollar (254 simwol)
Numeric san
Float bolek sanly sanlar
Integer san
Data ay, giin, yyl.
Logical TweF
Memo uly tekstler iicin
General ole obyektleri
Currency pul formaty
Tablisany doretmek — bu tablisanyn strukturasyny

kesgitlemek we ony dolandyrmak prosesidir. Belli bir
kesgitlenen meseldni yerine yetirmek tgin Visual Foxpro
ulanyja kop sanly ussatlary, konstruktorlary hodiirleyar.
Tablisa doretmegin diirli usullary bar. Programmirlemede
tablisa doretmek ticin CREATE DBF ya-da CREATE TABLE
komandalary ulanylyar. Tablisany komanda penjiresiniii
komegi bilen hem doredip bolyar, onun tablisanyn yerlesjek
yerini hokmany kesgitlemeli bolyar. Aktiw disk we katalog
barada maglumat almak {igin CURDIR funksiyasyny bermeli.
Gerekli katalogy gurnamak ticin SET DEFAULT TO *“yol”
komanda bilen kesgitlenyr.

Mysal : SET DEFAULT TO C:\STUD\

Basgaca  yoly = TOOLS-OPTIONS  komandada
kesgitlenyar. Create komandasyndan soni Table Designer
dialog penjiresi acylyar. Tablisanyii adyny goni komandada
hem berip bolyar. Mysal: CREATE TPI TABLISA.
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Tablisany File — New — Table menyudan hem doredip bolyar.
Tablisa at berilenden sonra Visual Foxpro Table Designer
penjiresini agyar we Fields, Indexes, Table atly wkladkalary
gorkezyéar. Tablisanyn strukturasyny bermek Ticin Fields
komandasynyn komegini ulanmaly.

NAME TYPE WIDTH DECIMAL INDEX NULL
yazgylar ¢ykyar, Sanlar girizilende bolek sanlary bolmagy
miimkin, onun {icin Decimal meydangasy ulanylyar.

Mysal: 99.999 {igin Width = 6; Decimal = 3.

Mysal : doredilen tablisa:

Meydan ady | meydan tipi | meydanyn diiziimi
Group numeric gruppa nomeri
Name character talybyn ady
Stip numeric talyp haky
Data date okuwa giren wagty
Photo general talybyn suraty

TAB diiwmesi  kursory siitiinlerin  arasynda

hereketlendirydr. Téze meydan girizmek {dgin INSERT
diiwmesini basmaly. CTRL+W tablisanyn strukturasyny yatda
saklatmaga komek edydr. Bos tablisa maglumat girizmeli
bolsa, onuii iigin View — tablisany saylamaly — Append mode
komandany bermeli. Tablisanyn asagynda Esclusive rezimi
gorkezilydr, yagny tablisa basga ulanyjylara el yeterli déldir.
Tablisany masterin komegi bilen hem déredip bolyar, bu yerde
birnidce ddim netijesinde tablisa doreyir.

Cancel — master bilen isi tamamlayar.
Back — bir d4dim yza gaytaryar.
Next — indiki 4dime ge¢mek.

Ulgam menyuda Tools — Wizard — Table saylamaly.
Jemi: 4 dadim bar. 1-nji 4dim tablisa saylamak. Bu yagdayda
tayyar standart tablisalar we olaryin meydanlary anyk Available
Fields toplumda gorkezilyir, olarynn gereklisini saylap >

24



diiwme bilen Selected Fields topluma gegirmeli. 2-nji ddimde
meydanlaryin modufikasiyasyny gecirip bolyar. Bu yerde
meydanlaryn atlaryny, tiplerini we bagsga kesgitlemeleri
iytgedip bolyar. Eger saylanan meydanyin gabadynda Allow
null Values belligi kesgitlense, onda sol meydany yazgysyz

goyup bolyar.

Step2 Modify Field
Field name

With

Decimals

Cancel Back Next

3-nji 4dimde indeksler doreilyir. Gerekli meydanyn gabadynda
bellik goymaly.
4-nji ddimde is tamamlanyar, bu yerde birndge menyu
hodiirlenyér :

1. Tablisany yapmaly;

2. Tablisany goérmeli we dolandyrmaly;

3. Tablisanyn strukturasyny modufisirlemeli.

5. Tablisalary dolandyrmakda ulanylyan operasiyalar.

Visual Foxpro-da tablisalary redaktirlemek,
indeksirlemek yaly operasiyalary programmanyn komegi bilen
ya-da yoritelesdirilen dialog penjirelerin komegi bilen amala
asyryp bolyar.

Fayly iki yagdayda acyp bolyar :
File—open Ya-da komanda Command penjirede USE
<tablisanyn ady>

Use komanda bilen hasabatyn, formanyn, taslamanyn
islendik faylyny acyp bolyar. Islendik tablisanyn iki yagdayy
bar :

Exclusive — monopol rezimi.

Open as read only — dine okamak tigin.
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Tablisany redaktirlemek {ii¢in Append, Insert, Edit
komandalar ulanylyar. Tablisanyn strukturasyny iiytgetmek
ticin Modify structure komandany bermeli.

Eger isit dowamynda sol bir komandalary ya-da sol bir
simwollary gaytalap girizmeli bolsa, onda makros ulanmak
maslahat berilyér.

Set Function <diiwmeler> to <simwol setiri> - bu
makrosyn umumy yazgysy.

Mysal : Set Function <F9> to ‘clear’ komandasy F9
diiwme bilen ekrany doly arassalap bilyar.

Clear Macros 4&hli makroslary ayyryar. Makrosy
yazmak ti¢in Tools — macros yoly agmaly we New
komandasyny bermeli.

Defined key — yazgyda diiwmeleri kesgitlemeli.

Macro name — yazgyda etjek isini kesgitlemeli.

Ahli edilen kesgitlenmeler .fky gifieldilmeli makros faylyna
yazylyar.

Tools — Macros — Clear — All — &hli makroslary yok edyar.
Browse komandasy.

Browse komandasy tablisalary redaktirlemekde in
gliycli gurallaryn biri, onun yorite Browse — penjiresi we
gosmaga komandalary bar. Mysal ii¢in : CTRL+Y tdze yazgy
gosyar, CTRL+T yazgyny yok edyir.

Browsyn aktiw penjiresinde siitiinlerin  6lgeglerini,
yerlerini tiytgedip bolyar.

No Append — Ctrl+Y ditwme bilen tize yazgy gosup
bolmayar.

No Delete — tablisadan yazgy yok etmeli dal.

No Edit — redaktirlemek gadagan.

Freeze <meydanynn ady> - dine kesgitlenen meydany
redaktirldp bolyar.

Set Autosave on — awtomatiki yagdayda girizilen
maglumatlary yatda saklatdyryar.

Komanda LIST.
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Bu komanda &hli tablisalaryil iginddki yazgylary ekrana
cykaryar.

Umumy yazgysy :

List [ Fields <meydanlar> ] [ For<> ]

[ While < >] [ off ] [ to printer ]

[ To file < faylyn ady > |

Su komandanyn netijesinde FOR we WHILE
operatorlardaky sertlere layyk gelydn vyazgylar ekrana
cykarylyar. Off komandasy yazgylaryn tertip nomerini ayyryar,
meydanlaryn atlaryny ¢ykarmazlyk {cin Set Heading off
komandany bermeli.

Kéhalatda berlen serte layyklykda tablisanyn
meydanlaryndaky yazgylary birbada iiytgetmeli bolyar. Bu
vagdayda Replace komandasy ulanylyar.

Umumy yazgysy :

Replace <meydan1> with <afilatma>

<meydan2> with <anlatma>
Mysal : Replace aylyk haky with aylyk haky *1,2;

Tablisadan maglumatlary Yok etmek iicin For
komandasy ulanylyar, bu komandanyn netijesinde dhli
yazgylar yzagaytarylmasyz ayyrylyar. Ayratyn yazgylary yok
etmek belligini goymak Ctrl+T basmaly ya-da Delete
komandasy ulanylyar.

Delete [aragédkler] While <aiilatma>, For <anilatma>

IKinji gezek CTRLAT basylsa, yok edilmeli diyilen
bellik ayyrylyar ya-da

RECALL [aragikler] While <ainlatma>, For <ainlatma>

Tablisany tertiplesdirmek {icin PACK komandasyny
ulanmaly. Doly tablisany yok etmek ti¢in ony ilki yapmaly.

Close All

Mysal: Erase MITDAU.dbf

Tablisadaky hereketlendiriji komandalar.

Bir yazgynyn ya-da topar yazgylarynyn istiinde
islemek ticin ulanylyan komandalar :
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- GO TOP ya-da LOCATE - kursory birinji yazgyda

goyyar;
- GOBOTTOM — sonky yazga gegydr;
- GON — N yazga gecyir;
- SKIPN — N yazgyny sanap,
kursory goyyar.

Visual Foxpro fayllaryn we disklerin yagdayyny kontrollykda
saklayan birnid¢ce funksiyalary hodiirleyar. Haysy yazgyda
durlandygyny bilmek {i¢in

RECHO () komandasy ulanylyar.

RECCOUNT ()- agyk tablisanyn yazgy sanyny kesgitleyar.

Mysal:

Use Mitdau
? RECCOUNT () * RECSIZE ()

Mitdau tablisada yazgylaryn tutyan yeri (baytda)

Disk space () - diskdéki bos yer.

BOP — kursor yazgynyn basynda dursa.

EOP — funksiyasy True gaytaryar, eger-de tablisada yazgy
yok bolsa ya-da kursor faylyn ahyrynda bolsa 42 yazgy bar.

? RECHO () 1-nji yazga gegyar.
GOTO7 7-nji yazga gegyar.
SKIP 5 2-nji yazga gegyar.
DELETE 2 2-nji yazgy yok edilyar.
RECALL 3-nji yazgyny dikeldyar.

41 yazgy galdy.

Tertiplesdirilmedik tablisadaky gecirilyan gozlegler.

Belli bir talabyn esasynda talapdaky serte gabat gelyidn
yazgylary bir topara jemlemek amatly bolyar. Sonun ii¢in dhli
maglumatlaryn tstiinde isleyji komandalar difie bir kesgitlenen
yazgylaryn topary bilen islar yaly Visual Foxpro-da
filtrleri(stizgiicleri) ulanyarlar.

Set Filter to <anlatma> komandasy yazylan anlatma
True jogaby beryin yazgylary tapawutlandyryar.

Mysal: Set Filter to ady = ‘Batyr’
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Batyr atly yazgylary saylayar. Filtri(siizglji)
ayyrmak ti¢in Set Filter to yazmaly, yagny hi¢ hili operasiya
ulanylmayar. Tertiplesdirilmedik tablisada gerekli yazga
kursory geg¢irmek iicin Locate komandasy ulanylyar.

Locate [ For <anlatma>] [ aragdk] [While <anlatma> ]

Locate bilen Continue komandalary — ti For
operatordaky anlatma ¢yn bahany beryin yazgy tapylyanca
tablisany doly gozden geciryar.

Asakdaky mysalda ekran arassalanyar, tablisa agylyar,
topar belgisi 24-¢ den bolan talyplaryn atlary we yazgy
nomerleri ¢ykarylyar.

Clear

Use talyp * tablisanyn ady
Locate For Group =24 do While found () ?

Recho (), name, continue end do

Su komandalar tertiplesdirilmedik tablisalarda gozlegi

hayal geciryérler.

6. Tablisalary indeksirlemek.

Gozleg prossesini yokarlandyrmak ii¢in indeksirlemek
usulyny ulanmak maslahat berilydr. Indeksirlemegin umumy
yazgysy :

Index on <anlatma> to <indeksirlenjek faylyn ady>
[ For <anlatma> ]
[ Descending ] [ Unique ] [ Additive ] [ Compact ]

MITDAU.dbf  tablisanynn topar nomerini, toparyn
icinde bolsa talybyn ady indeksirlemek ti¢in ilki san tipinddki
Group meydany simwol tipine gecirmeli.

Index On [STR(Group) + name to gn For talyp haky <
2 000 000 ? RECHO ()]

For talyp haky <2 000 000 ? Recho ()

Descending operasiyasy yazgylaryny indeksirlenende
peseltme usuly ulanyar.

Mysal : 10 9 7;
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Unique gaytalanyan yazgylary ayyryar. Index
doredilende basga index fayllar yapylmaz yaly ADDITIVE
opsiyasy ulanylyar.

COMPACT opsiyasy — kdbir gaytalanyan yazgylary
bir gezek yazyp, bellik goyyar (tablisanyn géwriimi 5-6 esse
kigelyar).

1dx gineldilmeli indeks fayllary tegler hokmiinde .cdx
gineldilmeli birndce indeks fayllaryn isini dolandyryan multi
indeks fayla birikdirilydr. Multi indeks fayly asaky komanda
bilen doreilyar:

Copy index <.idx fayllaryn spisogy > \ All [to <.cdx
faylyn ady>

To yazgysy ulanylmasa, onda tablisa agylanda ady bilen
hem multi indeks fayly doredilydr. Kop meseleler ¢oziilende
indeks fayly ulanmak maslahat berilyér, sebibi tablisada bolan
iytgesmeler netijesinde indeks faylyna hem awtomatiki
iytgesme girizilyar. Eger indeks fayly doredilen bolsa, ony
tablisa bilen acyp bolyar, onun ii¢cin

Use <tablisanyn ady> in <nomer >

Index <idx, cdx fayllary> [Again] [ no update]

Again opsiyasynyn komegi bilen tablisany basga is
meydanynda agyp bolyar. No update “dine okamak™ rezimini
beryir.

Mysal : Use talyp.dbf index name.idx IN 1;
1-nji i3 meydanynda talyp tablisasy we name index fayly
agylyar.

Vsiual FOXpro-da jemi 32767 is meydany bar. Index fayllary
barada maglumatlary almak ii¢in :

Dir *.idx

Dir*.cdx komandalary bermeli.

Indeks .idx fayllary agylyp biliner :

Set index to <indeks fayllaryn spisogy>

[ADDITIVE]

Mysal :

Use talyp
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Set index to group
Set index to name
Additive

Bu yerde Group birinji kesgitlenen, ol hem yazgylara
bolan rugsady dolandyryar. Indeksi ¢alysyp hem bolyar :

Set order to TAG <ind.ady> ya-da Use talyp index group,
name Set order to 2

Set (order) funksiyasy multi indeks faylyin adyny we yoluny
kesgitleyar.

Belli kesgitlenen meydana indeks doredilen bolsa, onda
gozleg prossesi c¢altlyk bilen amala asyrylyar. Simwol
meydanlarda bolsa maglumatlary goézlemek {icin FIND
ulanylyar.

FIND <simwollaryn yzygiderliligi>
Set Exact on opsiyasy kesgitlense, onda gozlenyin simwollar
setirint doly dowamynda gdzlenilyér. Mysal :

Use talyp index name
Set Exact on

Find Batyr

? name - jogap Batyr
Set Exact off

Find Berdi

?name - jogap Berdi
Kopleng Find — komandasyna derek SEEK komandasy
ulanylsa gowy bolyar.

Mysal :

Use talyp index name

Seek “Ber” - bu yerde tablisadan Berdiyew
familiyaly talyby tapyar.

Gerekli yazgy tapylmasa, kursor faylyn soiky
yazgysynda goyulyar. Bu komanda has hem DATA we san
meydanlarynda amatly bolyar. Set near on in golay bahaly
yazgyny tapyar. Mysal :

USE talyp index sum
Set near on
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Seek 1140
Browse
1140 yazgy yok, netijede 1150 bahaly sum meydanynda

kursor goyulyar. Asakdaky mysalda Berdiyew familiyaly
talybyn topary kesgitlenyér:

Use talyp

Set order to TAG name

If seek ([Berdiyew] ‘talyp’, 'name’ )

? group

Endif

Mysal : 24-nji topara degisli talyplar gorkezilyar.
Use talyp index group

If seek (24)
List name where group = 24
Endif
Mysal : tablisa doretmeli. Index doretmeli we

redaktirlemeli. FAM Berdiyew bolan talyplaryn haklaryny
2 000 000 denlemeli.

Create table group

Set index name to group idx

If seek FAM = *Berdiyew’

Talyp haky = 2 000 000

? group

Endif

Mysal :
Use MITDAU.dbf
Set index name, FAM
Set order to name
Set exact on
Find Berdiyew — jogap Berdiyew
Set exact off
Find B — Baylyyew
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Mysal : tablisa doretmeli, diiziimini liytgetmeli, maglumat
girizmeli. Yaliiyslyk goyberilende ses signaly bolmaly,
programmanyi isini kesmeli dél, goyberilen yaliiyslyklary
zurnala yazmaly, renk bermeli, American data kesgitlemeli,
KTU papkada yarlagdirmeli.

1. Create table MITDAU.dbf

2. Modify strukture Meydan ady tip Slceg
3. Browse

4. Set bell on ses signaly

5. Set escape off isini kesmeli dl
6. Set logerrors on zurnal

7. Set data American

8. Set default to <C:\KTU>

7. Tablisalar bilen islemek.

Birndge tablisalaryn berlenleri bilen islemek {i¢in olary
umumy meydan boyunca baglanysdyrmaly ya-da Ozara
gatnasygy (relation) kesgitlemeli. Su sebdpli Visual Foxpro
tablisalaryna relyasion diyilydr. Bu tablisalarda gaytalanyan
maglumatlar salynmayar. Artykma¢ maglumatlary ayyryan
prossese normalizasiya diyilydr, bu yagdayda programmalar
yenillik bilen gozleydir we maglumatlaryn bitewiligi
saklanylyar. Maglumat bazalaryn relyasion modeli, relyasion
modelin matematiki prinsiplerine esaslanyar. Her tablisanyi
strukturasyny kesgitlemek {i¢in, ilki bilen funksional
baglanysygy kesgitlemeli bolyar. Visual Foxpro tablisalary
birikdirmdge miimkingilik beryir. Eger iki is meydanynda
tablisalar agyk bolsa, JOIN komandasy sanalyp ge¢ilen
meydanlary birikdirme serte layyklykda birikdirydr. Kopleng
birikdirilen meydanlar belli bir obyekt barada maglumat
saklayarlar.

Join with <meydan> to <tdze fayl>

For <birikdirme serti>

[Fields<meydanlaryn spisogy>]
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Mysal : Tablisalaryin atlary we telefonlary iki tablisalarda
yerlesdirilen. Olary ii¢iinji
tablisa birikdiryérler.
Use MITDAU in A * ais meydany
Use Phone in B *
Join with Db to service for
Name = b.name fields name, order, b.phone
Use service * 3-nji tablisanyn ady
Browse

Kédhalatlarda meydanlaryn  bahalaryny  sortlamak
prossesinden geciryarler. Umumy yazylysy :
Sort <aracédkler> to <tablisanyn ady>
[ASCENDING / DESCENDING / ON <meydan>]
[/A] [/C] [/D], [meydan] [/A] [/C] [/D]
[While <anlatma>] [For <anlatma>]
Fields <meydanlaryn spisogy>

/A —beygeltmek, /C — setir we yazmak, /D — kemeltmek.
Mysal : Use MITDAU
Sort on talyp haky /A to MITDAU sort
Browse

Bir tablisa beyleki tablisadan maglumatlary gecirmek.

Iki tablisanyn strukturasynda menzes meydanlar bar
bolsa, onda bir tablisadaky berlenleri beyleki tablisa gegirip
bolyar. Umumy yazylysy :

Append From <faylyn ady>

[Fields <meydanlar>] [For <aiilatma>]

[TYPE <faylyn tipi>]

Mysal : Use talyp.dbf'y.
? Reccount () * yazgylaryn sany.
Append from new.dbf ?
Reccount () * yazgy sany kopeldi.
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Fayllary kopirlemek prossesi COPY komandasy bilen amala
asyrylyar. Umumy yazylysy :
Copy to <tdze faylyn ady>
[<aragikler>] [fields <meydanlar>]
[For <sert>]
[While <sert>]
[Type <faylyn tipi>]
[with cdx]
Bu komanda agyk tablisadan maglumatlary tize fayla
gecirydr. [with cdx] multi indeks fayly hem kopirleyér.
Mysal :
Use kitap
Copy next 100 to D:\kitaphana fields
Ady, yyly, for, yyly > 2 000
Yapyk .dbf fayllardan basga #hli fayllaryn gifieldimesine
yazmaly.
Mysal :
Copy MITDAU.prg to MOTT.prg
Yapyk tablisalary kopirlip bolmayar.
Close all
Copy MITDAU to MOTT
Tablisalaryn diizimini (strukturasyny) kopirldp bolyar.
Use MITDAU
COPY structure to MOTT
Display structure.

Sotiky acyk tablisa USE bilen yapylyar. Doly yapmak
iicin Close all ulanylyar. Erase — doly diskden og¢iirydr. Ahli
gerek maglumatlary DIR komandasy bilen alynyar.

8. Visual Foxpro-da programmirlermek.

Islendik programma doretmek iicin tekst redaktory ise
girizmeli.
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Fiel — New — program — new file komandalaryny
bermeli. Su komandalardan sonra Modify Command
komandasy ise girisyar.

Umumy yazylysy :

Modify Command <prog.ady>

[No edit] [No menu] [No wait]

[range n start character, n end character]
[Window [< penjirdninl ady 1 >]]

[In [window] <penjirdnin ady 2> | in screen]
[as n code page] [same] [save]

No edit — redaktirlemek gadagan;

No wait —  cekranyn  beyleki  obyektlerini
aktiwlesdirip bolyar.

Window

[penjirinin ady] — ulanyjy programmasy tiigin 6z yerini
kesgitleyr.

Modify Command * komandasy &hli programma
fayllaryn atlaryny ekrana gykaryar. Programmada kommentariy
* simwol bilen goyulyar. Programmada Edit options bilen
kommentariyalara, esasy sozlere, operatorlara, simwol
setirlere, tytgeyan ululyklara refik berip bolyar. Yazylan
programmany Ctrl+W bilen yatda saklamaly. Programma Do
<faylynn ady> komanda bilen ise goyberilydr. Kompilirlenen
faylyn gineldilmesi .fxp bolyar. Islendik wagt programmanyn
isini kesip bolyar : Set Escape On komandasyny ulanmaly.

Adaty programma fayly asakdaky elementlerden
ybarat :

1. Programma faylyn sOzbagy. Esasan
kommentariyalardan ybarat bolyar.
+ programmanyh ady. MITDAU.prg
+ maksady — gozleg.
+ Doretdi — talyp — Owezow.
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2. Programmanyn gurnawlar boliimi. Esasan formatlary,
sesleri, renkleri, habarlaryn g¢ykarylysyny kesgitleyar.
Mysal {i¢in :

clear;

clear memory;

close all;

clear macros;

set color of 3;

set data German;

set avtosave on.

e

3. Programmanynn  operasion  boliimi.  Esasan  is
meydanlary, fayllary agmak prosesleri yerine yetiryar.

4. Programmanyi jemleyji bolegi. Tamalayjy
komandalary 6z igine alyar. Mysal {i¢n :
+ On key;
+ Clear all.

9. Programmirlemede iiytgeyéin ululyklary ulanmak.
Uytgeyin  ululyklary  programmanyfi  basynda
kesgitlemek maslahat berilydr. Ululyklaryn atlary harp bilen
baslamaly, esasy sozler bilen gabat gelmeli dil. Uytgeyin

ululyklary doretmek {icin asakdaky komandalar ulanylyar :

Mysal 1 :

a=2,

v ="MITDAU’;
Mysal 2 :

Store <anlatma> to <ululyklaryn atlary>
Store 27 to a,b;
Netijede a = 27; b =27,

Basgaca ululyklar massiwin elementi hokmiinde hem
kesgitlenip biliner.
Umumy yazylysy :

Dimension <massiwin ady> (<massiwin 6lgegi>);

37



ya-da

Declare <massiwin ady> (<massiwi 6l¢egi>);
Mysal :

Declare KTU [5];
Massiw iki 6lcegli bolup hem biler.

Mysal : Dimension MITDAU [2.2]
MITDAU [1.1] =5; MITDAU [2.1] = -9;
MITDAU [1.2] = -3; MITDAU [2.2] = 5;

Tablisa berlenlerin iistiinde diirli amallary yerine yetirip
bolyar, esasan count, sum, averase funksiyalary bar.
Mysal : Use MITDAU * tablisa acyldy.
Sum talyp haky For name = ’Berdiyew’ to;  (jem)
Count For name = "Berdiyew’ to; (sany)
+ nige gezek talyp haky tolenipdir.
Averase talyp haky to (m)
+ orta talyp haky.
Calculate max (talyp haky) to max;
+ i uly talyp hakyny kesgitleyir.

Massiw bilen tablisanyn arasynda maglumatlary gecirip
bolyar. Bu yagdayda iki komanda ulanylyar : SCARTER we
COPY TO ARRAY.

Umumy yazylysy :

Scarter [Fields <meydanlar> to <massiwii ady>]

Sanalyp gecilen meydanlarynn bahalary degislilikde
massiwin elemenlerine dakylyar. Massiwden tablisa maglumat
gecirmek ii¢in agakdaky komanda ulanylyar :

Cather From <massiwin ady> Fields <meydanlar>
Mysal :  3-nji yazgynyn ady we familiya meydanlaryn
bahalary mas massiwe gegirilyar, bahalary calysyar
we yzyna gecilyar.
Use MITDAU
Goto3
Scarter Fields ady, Fam to mas
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? mas (1)

* Berdiyew
Input ’téze at’ to mas (1)

* tize at girizmeli
? mas (2)

* Parahat
Input "Tédze FAM’ to mas (2)
Cather From mas Fields ady, FAM
? ady
? FAM

Use  * doly tablisany yapyar.

Mysal : “Talyp” tablisada yok edilmeli yazgylar basga
“Talyp(1)” tablisa ge¢irilyar.
Use talyp in a
* a i3 meydanynda talyp tablisasy
Use talyp (1) inb
* b i3 meydanynda talyp (1) tablisasy
Select a
* talyp tablisasy aktiw yagdayda
Scan For Deleted ()
* yok edilmeli yazgylar bellenilyar.
Scarter memo to memvar
* yok edilydn meydanlaryn bahalary we 6zler1 tiytgeyan
ululyklara dakylyar.
Select b
* b iy meydany aktiw yagdayda
Go bottom
* tablisanyn sofiuna gecmek
Append blank
Cather From memvar memo
* memo dhli tiytgeyan ululyklary talyp (1) tablisasyna
gecirmeli.
Select a
End scan
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Pack
* talyp tablisasy tertiplesdirilyar.

10. Sertli we sikliki operatorlar. Programma
modullaryn ulanylysy
Hasaplayys prossesi dolandyrmak tgin IF, END IF,
SCAN, END SCAN, DO WHILE, END DO, DO CASE, END
CASE, FOR, END FOR operatorlary ulanylyar.
Umumy yazylysy :
If <sert>
Else
End if.
Mysal :
If not empty (dbf ())
Public sany
Sany = reccount ()
Else
Wait * Aktiw tablisa yok’
Endif
? >aktiw tablisanyn ady’, dbf ()
? ’yazgy sany’, sany.

Bu yerde Public — tytgeyan ululyklar. Bu meseldnin
netijesinde agyk tablisalaryn atlary we yazgy sanlary
gokezilydr. Do case, end case komandada bir nége sertler
barlanylyar. Sertlerin hi¢ haysy yerine yetmese, onda Other
wise operatorynyil yzyndaky operatorlar yerine yetyar.

Umumy yazylysy :

Do case

Case <sert 1>
Case <gert 2>
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Other wise
End case.

Mysal :
on error errorevent ()
* yalilyslaryn tstiinde isleydn komanda
Prosedure errorevent
* yaliiyslaryn iistiinde isleyén prosedura
Do case
Case error () =5
Wait window ’yazgynyil nomeri yalilys’
Case error () =20
Wait window ’indeksde yazgy yok’
Case error () =56
Wait window ’diskde yer az’
Other wise
Wait window ’Nétanys yalilys goyberilen’
End case
Return
End prog
Do while, end do — sikl operatora degisli.
Umumy yazylysy :
Do while <sert>
End do
Mysal :
Use MITDAU
Index on name to MITDAU
Seek "Pa’
Do while name = "Pa’
? Reccount ()
End do
Netijede : ,,Pa* harplaryndan baslayan talyplaryn atlarynyn
sany gorkezilyir.
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For, end for operatory sikller ii¢in ulanylyar.
Umumy yazylysy :
For <iiyt.ulul> = <bas.baha> to
<ahyrky baha> [step <ddim>]
<komandalar>

End for ya-da  next
Mysal :

Dimension cfile (2)

Cfile (1) ="MITDAU.dbf

Cfile (2) ="MITDAU.prg’
Fori=1to 6

Copy file (cfile (1)) to (cdir)
End for.

Netijede iki sany fayly kopiyalayar.

Scan, end scan komandalary hem tablisalarda ginden
ulanylyar.
Umumy yazylysy :

Scan [ara¢ék] [for-sert] [while-sert] [exit]
<komandalar>

End scan.

Mysal :

Use MITDAU.dbf

Scan for talyp haky > 1 000 000
Replace dereje with *yokarlandyrylan’

End scan.

Programma modullaryn ulanylysy.

Visual Foxpro-da programma fayllary prg, spr, mpr,
gpr giteldilmeli bolup bilydr. Programmanyn diiziiminde
funksiyalar we proseduralar hem giiidden ulanylyar. Modullara
boliinen programmanyn yerine yetirilisine lins bermek yenil
bolyar. Islendik programma :
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Do <programma faylynyn ady> with <fakt.

parametr> in <fayl>

Eger-de prosedura basga faylyn icinde yerlesen bolsa,
onda IN opsiyasy ulanylyar. Programma modullary
birikdirmek ti¢in Parametrs <formal ululyklar> komandany
ulanmaly. Asakdaky mysalda main.prg programmadan
minim.prg programma ¢agyrylyar. ki sandan in kigisi
gorkezilyar.

Main.prg
Clear
Public a,b
Input “a-ny girizin”, to a
Input “b-ni girizin”, to b

Do minim with a,b

Minim.prg
Parametrs x,y

Z=1IF (x<y, Xx,Y)

? ’minimal san’, Z
Return.

11. Maglumatlaryn iistiinde islemegin interfeysini
doretmek.

Cylsyrymly ulgamlar bilen islenilende maglumatlary
grafiki obyektleri, tablisa berlenleri mydama ekranda gérmek
ticin yoritelesdirilen penjireleri doredip bolyar. Birndge aktiw
penjire doredip bolar, yone il sonkysy aktiwlesdirilen, yagny
kursorly bolar.

Penjire doretmek iicin asakdaky komanda
ulanylyar:

Define window <penjirdninl ady>
From <yl,x1> to <y2,x2> | At <y,x> size <boyy, ini>
In window <esasy penjire> \ in screen \ in desctop
Name <obyektin ady>
Font <ady>, <6l¢egi>
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Style <diistindiris setiri>
Footer <habarnama>
Title <sdzbagy>

HALF HEIGHT

Double / panel / none / system
Close / no close
Float / no float
Crow / no crow
Minimize / no minimize
Shadom / no shadom
Zoom / no zoom
Icon file <faylyn ady>
Color scheme <nomer>/ color <reiiklerin jiibiidi>

Fill File <faylyn ady>

From we At

IN WINDOW

IN SCREEN

TITLE

FOOTER

DOUBLE / PANEL /
NONE / SYSTEM

CLOSE / NO CLOSE

FLOAT / NO FLOAT

CROW /NO CROW

— penjirdnin ekranda ya-da esasy
ene penjirede yerlesjek yerini
kesgitleyar.

— basga penjirdnin i¢inde penjire
doredyar;

— ekrana maglumatlary c¢ykaryp
durmak;

— penjirdniit yokarsynda sozbagy
doredyir;

— ekranyn asaky Dboleginde
habarlary gorkezyir;

— penjirdnin
kesgitleyar;

— penjirdni sycan we klawiatura
tarapyndan  yapmaga rugsady
kesgitleyar;

— penjirdni siiysiirmek rugsady
kesgitleyar;

— penjirdnin dl¢eglerini

aragéklerini
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tiytgetmége rugsady kesgitleyar;

MINIMIZE /

NO MINIMIZE — penjirdni yygnamak rugsady
kesgitleyar;

SHADOM / NO SHADOM - Penjiréni {ig¢ 6lgegde gorkezyar;

ZOOM /NO ZzOOM — ekrany doly a¢mak rugsady
kesgitleyér;

ICON FILE — penjire licin bellik  kesgitleyar;

COLOR SCHEME /

COLOR — reiik ya-da reniklerin toplumy
ulanylmaly;

FILL FILE — penjirdnin yzky gorniisini BMP
fayl bilen dolduryar.

Doredilen penjirdni programmanyn icinden

aktiwlesdirmek iicin asakdaky komandany bermeli :
Activate window [penjirel ady] [penjire 2 ad.]... / ALL
In window <ene penjirdniii ady>/ SCREEN

[Bottom] / [Top]

[No show]

Bottom / top — penjire beyleki penjirelerden yzda
ya-da onde duryar.

No show — penjirdni gorkezmeli dal.

Visual Foxpro-da kalkulyator, kalendar
penjireleri ulanyp bolyar:

Activate window Calculator ya-da
Activate window Calendar
Aktiw  penjireleri asakdaky komanda bilen goze
goriinmeyéin edip bolyar:
Hide window [penjire 1 ady], [penjire 2 ady].../ ALL
In window [ene penjire] / Screen
Penjireleri gormek iicin :
Show window [penjire 1 ady], [penjire 2 ady].../ ALL
Penjirini husdan ya-da ekrandan ayyrmak iicin :
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Deactivate window [penjire 1 ady], [penjire 2 ady].../ ALL
Kesgitli penjirinin yerlesisini we olcegini iiytgetmek iicin :
Zoom window [penjire ady] min / max / normal
At <x1, y1>/ From <x2,y2>
Ekrandan we husdan penjireleri ayyrmak iicin :
Release windows [<penjirelerin atlary>]
ya—da
CLEAR WINDOWS.
12. Dolandyryjy elementlerin déredilsi we ulanylsy.

Dirli gorniisli dolandyrma prosseslerde we Visual
Foxpronyn berilenlerine rugsat almakda GET-obyektler
ulanylyar, bu obyektlerinn biri saylanylan yagdayynda degisli
kod yerine yetirilyar.

Umumy yazylsy:
@ y,x get <iiytgeyéan ululyk>|<meydan> function
<anlatma>| picture<anlatma>
Font<anlatma> | style <anlatma>
Default <anlatma>
Size <anlatma> , <anlatma>, <anlatma>
Enable|disable
Message <anlatma>
Valid <aillatma>|<anilatma>
When <arlatma>
Color scheme <anlatma>|color<renkler>

Asakdaky komanda gonburgly formally ok,cancel
diiwmeleri doredilyar:

@ 2,2 Get mchoice Function’* ok, cancel’
Default 1

Size 1,10,1

Font ‘Roman’, 16 stile ‘B’

Read

Check box 1ki yagdayly meydan doretmek iigin ¢
List Box Spisok
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Command|bottom géniburgly knopka *

Option bottom tegelek knopka *R

Spinner sanlary saylap bolyar *K

Check box

Mysal: clear @ 2,2 Get rac Function’*C ®naxok’Defauet 1

netije
J \4 daxok
List Box Browse.dbf
MITDAU.dbf
MOTT.dbf
Mysal:
NEXT
PREV
TOP
BOTTOM
A y Exit
Suratly menyu doredeli:
Top — tablisanyn basyna gegmek
Bottom — sonky yazga gegmek
USE MITDAU
SET TALK of

Define Window KTU From 3,5 to 20,20 Float Double
* penjire kesgitlemek.
Color Sheme 5
ACTIVATE WINDOW KTU
@ 1,2 Get Function ‘*Next, Prev, Top, Bottom, Exit’
Size 2,10,1 Val 10 go record () Default 1
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Read CYCLE

Clear Window
Procedure go record
Do case

Case mchoice =1
*eger Next baglan bolsa
If 1 EDF ()

Skip 1

End if

Case mchoice = 2
Eger prev baslan bolsa
If'EOF () *

Skip -1

End if

Case mchoice = 3

Go top

Case mchoice =4

Go bottom

Case mchoice =5
Clear read end case

13. Visual Foxpro-da maglumat bazalaryi ulanylysy.

Visual Foxpro-da maglumat baza hokmiinde tablisalaryn,
tablisa-ara gatnasyklaryn, proseduralaryn we funksiyalaryn,
operatorlaryn toplumyna seredilyar.

Maglumat bazasy Create database komanda bilen
doredilyar. Adaty datal.dbc ady ulgamyn 06zi kesgitleyir.
Maglumat bazany “ussadyn” komegi bilen 4 ddimde doredip
bolyar, her &dimde gerekli opsiyalara bellik goymaly bolyar.

Baza doredilenden sotira iki yagday hodirlenyar:

- yatda goymak;

- yatda goymak we konstruktor bilen modifirlemek.
Bazany konstruktirlemek icin COMMAND

penjiresinde Modify Database [<maglumat bazanyn ady>]
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komandany bermeli. Bazalar bilen islenilende esasy menyu

tdze “Database” atly punkt gosulyar.

Asakda yazgylar getirilen :

- new table — maglumat bazasynda téze tablisa déretmek;

- add table — tablisa gosmak;

- modify — tablisanyn diiziimini modifisirlemek;

- browse — maglumatlary gormek we iiytgetmek;

- remove — tablisany yok etmek;

- find object — tablisany gozlemek;

- edit relationship — tablisalaryn arasyndaky gatnasyklary

redaktirlemek;

- edit referential integrify — maglumatlarynn bitewiligi

ticin diizglinlerinl redaktirlenyan yeri;

- edit stores prosedures — saklanylyan proseduralary

redaktirlemek.

Maglumat baza bilen isleydn kop komandalar Database
Designer gurallar panelinde yerlesyir, paneli View — Tools —
Database Designer komandasy gorkezyir. Ahli maglumatlar
meydanlara girizilydr, su sebédpli Table Designer boliimde
meydanlaryn hésiyetnamalaryny kesgitldp bolyar.

Message atly yerde diisiindiris girizip bolyar.

Table Designer — de tablisalaryn hasiyetnamalaryny
hem kesgitlip bolyar. Kopleng yazgylary kontrollykda
saklamaly bolyar, bu yerde GETFLDSTATEO funksiyasy
ulanylyar, bu funksiya komanda yerine Yetirilip durka,
yazgylarda bolup ge¢ydn Tlytgesmeler barada maglumaty
gorkezydr.  Yazgydaky islendik iiytgesmd  “takyklyk
diizglinleri” tarapyndan yzarlanyar. Ulanyjy tarapyndan
kontrollyk iicin ulanyjynyn funksiyalary proseduralar
hokmiinde doredilmelidir. Bu is ii¢cin Database — edit stored
prosedure penjiresine proseduranyin programma kodyny
girizmeli.

Table Comment atly yerde tablisa {i¢in niyetlenen
kommentariy girizilydr. Triggers atly meydanda ii¢ sany
triggeri, yagny logiki tipdédki ailatmalary girizip bolyar, olar
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yazgylaryn istiinden gecrilydn Insert, Update, Delete
komandalaryna ulgamyn hereketini kesgitleyérler. Su sebépli,
Insert trigger, Update trigger, Delete trigger meydanlarda
degisli proseduralary cagyryan logiki ailatmalar yazylyar.
Mysal {igin konelisen maglumatlary yok etmek iicin Delete
trigger yerde ridel prosedura doredilyar.

Prosedure ridel

Local retval

If year (fdate) < 1994
Retval = .T.

Else retval = .F.
Endif

Return retval.

Retval — tiytgeyan ululyk ¢yn, yalan bahany alyp bilyr.
Gorkezilen tablisa degisli boljak triggeri programma yoly bilen
doretmek iicin agakdaky komandany ulanmaly.

Create Trigger On <tabl.ady> For Delete / Insert /
Update

As <logiki anllatma>

Delete Trigger On <tabl.ady> For Delete / Insert /
Update — komandasy maglumat bazadan triggeri yok edyar,
Table Designer penjiresinde Indexes wkladkada her tablisa
icin indeksleri kesgitleyir.

Indeksirlenen formanyn gorniisi asakda getirilen:
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Surat : Database Designer tablisa-ara arabaglanysygy gorkezyar.
Baglanysan tablisalaryn modifikasiyasynda
maglumatlaryn  bitewiligini saklamak ii¢cin kesgitlenen
diizgiinler — rules ulanylyar, yagny
Rules for updating — maglumatlary tiytgetmek diizgiini,
Rules for deleting — maglumaty yok etmek diizgiini,
Rules for inserting — maglumaty girizmek diizgiini bar.

Maglumat bazasy iicin
gorniis (predstowleniye) doretmek.

Ahli is meydanlarynda acyk bolan tablisalar, indeksler,
fayllar barada, tablisa-ara gatnasyklar barada, gurnawlar barada
operatiw informasiyany saklamak tgin View  gorniis
doredilydr.

Create View ya-da Database — New Local View
komandasy gorniisi doredyar.
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Surat : View Designer penjiresi.

File Save — yatda saklatdyryar we .vue gineldilme beryar.
Delete View — gorniisi yok edyar.

Maglumat bazanyi agylysy.
Tablisa saylanylmaly bolsa Database — Remove
komandany bermeli. Diskden tablisa iki tapgyrda yok edilyar :
- Remove yagdayda tablisa bosayar;
- Delete komandada doly yok edilyér.
Tablisany bazadan programma yoly bilen hem yok edip
bolyar, onun ii¢in :
Drop table <yok edilyin tabl.ady> ? [Recycle]
? - belgisi Remove dialogy ¢ykaryar, bu yerde
diskden ayyrmalydygy kesgitlenilyar.

Recycle — korzinada saklanmalydygyny anladyan komandadyr.
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Yok etmeklik baradaky komandalary habardarlyk bilen
ulanylmalydyr. Baza barada maglumaty bir tekst faylda
gormek ti¢in asakdaky komandany bermeli.

Display Database [TO FILE <tekst faylyn ady>] / [TO
PRINT]

Ya-da

LIST DATABASE

Bazadaky tablisalaryn atlary DISPLAY TABLES ya-
da LIST TABLES bilen ¢ykarylyar.

Bazany yok etmek iicin Delete Database komandasy
ulanylyar.

14. Hasabatlary doretmek.

Tablisalarda yerlesen maglumatlary gorkezmek {igin
hasabatlar ulanylyar. I yonekey hasabaty doretmek we
gormek ticin Display komandany bermeli, yagny netijede
maglumat ekrana, tekst fayla, printere ¢ykarylyar.

Mysal : MITDAU tablisanyn &hli yazgylaryny printere
¢ykarmaly.

Use MITDAU

Set heading off * meydanlaryn atlary ¢ykarylmayar.

Display date () to print

Display “ hasabat “ to print

Display all fields < saylanan meydanlaryn atlary > off
to print

Yazgylaryn tertip nomerini ¢ykarmazlyk iicin OFF
komandasy ulanylyar. Meydanlaryn {istiinde gecirilydn
matematiki funksiyalary ya-da toparlamak prossesini, aralyk
we ahyrky maglumatlary almak ii¢in hasabatda SQL talaplary
yasap bolyar, yone has professional derejeddki hasabatlar
FOXpro-nyn Report Wizard (mactep ordera) we Report
Designer (korctpykrop otdera) serisdeler arkaly gazanylyar.

Tools — Wizards — Report komandasy saylanylyar, eger-
de baglanysan tablisalarynn meydanlarynyn {iistiinde isleniljek
bolsa, onda One — to — Many Report Wizard saylanylyar, sofira
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Summary Options penjirdni ulanyp gerekli matematiki
hasaplamalar gegirilyar.

Fads Sum_Avg Coutl Mo Max A [ oK “

Dpay

Pey a2 1N B [lwu

' -
Wﬁm N Calculate fSetcent of total for sums
O Summary ony

| ONo otals

Surat: Summary Option penjiresi.

Hasabat {i¢in stili saylamaly we faylyn adyny
kesgitlemeli. Doredilen hasabat .frx fayllarda yerlesyér, bu
fayly islendik yerde ulanyp bolyar, yagny
Report From <hasabatyn ady> to printer [Prompt]

/ preview / to File <faylyn ady>[ASCII]

PROMPT opsiyasy print dialog penjiresini ekrana
c¢ykaryar, bu yerde printerin kédbir gurnawlaryny kesgitldp
bolyar.

File — New — Report — New File komanda berilende
degisli penjireler agylyar. Caltlyk bilen hasabat dorediljek
bolsa Report — Quick Report komandasy berilyar, bu yagdayda
dhli meydanlar awtomatiki  yerlesdirilydr. = Hasabatyn
konstruktorynda birndge aralyklar bar, olaryn dolandyrylyan
beyikligi, yorite tekst, ¢cyzgylar, suratlar yaly elementler bar.
Visual Foxpro elementleri bir aralykdan basga aralyga
gecimage miimkingilik beryar. aralyklar (mysalda) :
MITDAU
Date ()

Group meydanlaryn sdzbasy
Detail her yazgynyn meydanlary
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| Summary jemleyji maglumatlar ‘

Hasabaty konsturtirlemek prossesi asakdaky tapgyrlardan
ybarat :

- das-toweregi sredanykesgitlemek;

- teksti we meydanlary yerlesdirmek;

- suratlary, goniburglyklary we ¢yzyklary yerlesdirmek;

- hasabaty yatda saklamak .
Konstruktoryin gurallar panelini gormek iicin View -—
Report Controls Toolbar komandasyny bermeli.

Diiwme Edyén isi

Select Objects Islendik elementi saylap almak

Label Hasabata teksti girizmek

Field Hasabatda tablisanyn meydanyny
yerlesdirmek

Line Bolek ¢yzgyny gorkezmek

Picture/ActiveX Bound | Suratlary, ActiveX obyektleri

Control gormek

Button Lock Saylanan diiwmejigi berkitmek

oporiconos ¥
hAB+-UME &

Surat: Report Controls penjiresi

Hasabatda disiindiris — kommentariy girizilmeli bolsa
COMMENT atly yerde gerekli teksti girizmeli. Gaytalanyan
elementleri ya-da bos setirleri ayyrmak meselesi Print When
diiwméinin penjiresinde ¢oziilyar.

Detail atly aralykda (zonada) tablisanyn meydanlaryny
yerlesdirip bolyar. Data Environment penjirede agyk
tablisanyn islendik meydanyny saylap Detail aralyga gecirip
bolyar.

Islendik meydan goyulanda asakdaky penjire agylyar:
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Fomat:
G Chancter ® Numenc Olae
Eciting ophions
O Lot justiy (] C8 # positive
[0 Blark ¥ gero (108 if negatiye
[JiNegatne) [ Leading 20008
[JSETDATE fomat [ Crency]
(] Batish date [ scentic

Hasabatda  sriftleri, fon  yazgylary = goymak
miimkingiliginden dasary, diirli surat, emblemalary, her yazgy
iicin suratlary kesgitlemidge miimkingiligi bar. Bu is iicin
Report controls panelinde Picture/ActiveX Bound control
elementi saylamaly we gerekli yerde kesgitlemeli. Mysal {i¢in
her talybyn degisli suratyny goymak tigin General tipli meydan
bolmalydyr. Suratlar sygmadyk yagdayynda Scale picture, fill
the frame opsiyasyny saylamaly, bu yagdayda surat
proporsional yagdayda iiytgeydr. Layout instrumenti ayratyn
elementleri birikdiryédr. Color Palette refk meselesini ¢ozyar.
Doredilen hasabaty gozden gegirmekde FOXpro-nyn kop
serisdeleri bar.

15. Menyu doretmek.

Menyu doretmek — ulanyjy {i¢in &hli komponentlere
dostupy yeiillesdirmegi ailadyar. Kopleng taslama 6z hususy
menyusyndan ybarat bolyar we onun iginde kesgitlenen
meseleleri ¢ozmek iicin komandalary bardyr. Sol bir wagtda
talaplar, formalar, bazalar, tablisalar, programmadyr -—
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hasabatlar bilen islemek {iigin menyu doredilydr. Islendik
menyu iki tipden ybaratdyr:

- gorizantal;

- wertikal ;

Foxpro-nyin esasy menyusy gorizantal, ol birnége
gorizantal punklardan ybarat, olara PAD — punktlar diyilyar.
Mysal tigin: file, edit, view....

Yiize ¢ykyp gelyin wertikal menyu, yagny POPUP —
wertikal BAR  punktlardan ybarat, bular dine PAD
aktiwlesdirilen yagdayynda yiize ¢ykyarlar. Mysal {i¢in : File-
de new, open, save....punktlar yaly.

Bas we POPUP menyu asakdaky yagdayda
kesgitlenilyar:

Define menu / POPUP <menyunyi ady>
<esasy menyular kesgitlenilyér (PAD, POPUP, BAR) >
Activate menu <menyunyn ady>

Cylsyrymlylygyna  baglylykda  menyu  birnége
derejelerde taslanyar (menu level). I yokarky derejede bas
menu we ylize ¢cykyan POPUP menyusy kesgitlenilyér.

PAD — Menu (basg) degisli.
BAR — POPUP degisli.
PAD-laryii kesgitlenilisi. Mysal: | FILE [EDIT | ...... |
Umumy yazylysy:

Define PAD <PAD punktyil ady> of <PAD punkty alyan BAR
menyu>

Promt <PAD punktyn ady - nadpis>

[AT <x, y>]

[Before <punktyn ady>/After <punktyn ady>]

[Message <habar teksti>]

[Key]

[Color sheme]

Menu POPUP
Define popup <ylize ¢cykyan menyunyn ady>
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[From <x1,y1> to <x2,y2>]

Prompt fields <aflatma / prompt files [like <sablon>] / prompt
structure>

[mark < >]

[message < >]

[color sheme]

Mysal:

Clear

Define Popur popDemo

Define Bar 1 of popDemo prompt ' MITDAU '

Define Bar 2 of popDemo prompt ' MOTT '

Define Bar 3 of popDemo prompt ' OTPA '

Define Bar 4 of popDemo prompt ' GPYD*
Activate popup popDemo

Gorniisi seylerdk bolyar:

MOTT menyu
OTPA
GPYD

Yiize ¢ykyan menyunyit BAR punktlarynyi kesgitlenilisi:
Define BAR <punktynn nomeri> of <popup menyunyi ady>
prompt <aillatma>

[Before <punktyn ady>/After <punktyn ady>]

[message < >]

[slip for <anlatma>]

[color sheme < >]
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Programmalaryn islendik yerinden oniinden kesgitlenen
menyuny aktiwlesdirip bolyar we asakdaky komanda bilen
kesgitlenyar.

Activate menu <ady> ya-da

Activate popup <ady> [AT <y,x>] [Bar <nomer>]
Asakdaky “base” atly yiize ¢ykyan menyu doredilyar.

DEFINE POPUP base FROM 1,1 TO 5,35
DEFINE BAR 1 OF base PROMPT "\Maglumat girizmek'’
DEFINE BAR 2 OF base PROMPT "\<Diizedis girizmek'
DEFINE BAR 3 OF base PROMPT "\<Yok etmek’;
MESSAGE 'Habardar bolun!" COLOR, w+/r,,,w+*/r
DEFINE BAR 4 OF base PROMPT "\<Cap etmek'
DEFINE BAR 5 OF base PROMPT "\<Cykmak'
ON SELECTION BAM 1 OF base DO procl
ON SELECTION BAR 2 OF base DO proc2
ON SELECTION BAR 3 OF base DELETE
ON SELECTION BAR 4 OF base DO print
ON SELECTION BAR 5 OF base CANCEL

ACTIVATE POPUP base

PROCEDURE print

SET PRINTER ON

? PRINTSTATUS()

IF NOT PRINTSTATUSO

WAIT 'Printeri tayyarlamak!'

ELSE

LIST TO PRINTER

ENDIF

SET PRINTER OFF

CLEAR

RETURN TO MENU

“Cap etmek” punkty degisli prosedurany cagyryar.
Menyuny yok etmek {iigin : DEACTIVATE MENU |
POPUP,<menyunyn ady>
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16. Menyular bilen isleyin funksiyalar.
Doredilen menyunyn hisiyetlerini gaytaryan
yoritelesdirilen funksiyalar asakdaky maglumaty gorkezyar.
CNT BAR
(popup menyunyn ady) — yiize ¢ykyan menyuda setir sany.
CNT PAD (menyunyn ady) — menyuda punkt sany.
GET BAR () — saylanan punktyn nomeri.
GET PAD () — saylanan punktyn ady.
MENU () — aktiw menyunyn ady.
PAD () — menyu setirden saylanan punktyn ady.
POPUP () — popup menyunyn ady.
Mysal :
Wait Window ’Hézir’ + PAD () + ’punkty saylanan’ —
su sozlemi ekrana ¢ykaryar. Asakdaky mysalda iki derejeli
menyu doredilen.

Maglumat Gozleg Cykmak
Girizmek
Yok etmek
Maglumat atly punkta popinf atly Popup menyu degisli
Gozleg atly punkta popgdz atly Popup menyu degisli
USE stud
DEFINE MENU mainmenu
DEFINE PAD inf OF mainmenu PROMPT "< maglumat' AT 1,8
DEFINE PAD g6z OF mainmenu PROMPT "< gozleg' AT 1,30
DEFINE PAD exit OF mainmenu PROMPT \< Cykmak' AT 1,50
ON PAD inf OF mainmenu ACTIVATE POPUP popinf
ON PAD g6z OF mainmenu ACTIVATE POPUP popgoz'
ON SELECTION PAD exit OF mainmenu DEACTIVATE MENU
DEFINE POPUP popinf
DEFINE BAR 1 OF popinf PROMPT "\<Baslangy¢'
DEFINE BAR 2 OF popinf PROMPT "\<Soiy'
ON SELECTION BAR 1 OF popinf Browse
ON SELECTION BAR 2 OF popinf Delete
Menyu doredilende diiwmeleri ulanyp bolyar.
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Lastkey klawisanyn kodyny gaytaryar.
Mysal :
IF LASTKEY()=13
HIDE POPUP md
DISPLAY ALL
ENDIF
WAIT "'
IF LASTKEY()=32
CLEAR
SHOW POPUP md
ENDIF
Netijede: ENTER basylanda menyu yityar we tablisanyn
ahli maglumaty gorkezilydr, SPACE (kod=32)
basylsa Popup menyu tizeden ekrana
cykarylyar. Degisli komanda bilen diiwméni
baglanysdyrmak {icin On Key <komanda>
ulanylyar ya-da On Key Label <diiwménin ady>
<komanda>
Mysal :
ON KEY LABEL F5 DO nameproc
ON KEY LABEL F2 CLEAR
ON KEY LABEL ESCAPE DO r_quit
Umuman islendik menyuny menyunyi konstruktorynyn
komegi bilen hem doredip bolyar. Menyu fayla .mpr
gifieldilme berilydr. Menyuny ise girizmek ii¢in Do komandany
bermeli. Mysal {igin : Do MITDAU.mpr

17. Menyunyn programma faylynyn generirlemesi.
Menyuny ise girizmek iicin Do komandany bermeli.
Menyu doretmek iicin Create Menu komandany bermeli.
Emele gelyén dialog penjiresinde ulanyja gerekli menyulary
we olarynl etmeli islerini kesgitldp bolyar. Mysal iicin : 4 PAD
punktly menyu doredeli.

Serwis Edit Report Exit
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Calendar Degisli Fayly Programmadan

Calculator forma gbrmek, ¢ykmak we ekrany
alynyar. fayly printere arassalamak
ibermek.

Servis iki menyudan, Report iki menyudan ybarat bolyar.

H Menu Designer  studimnx

Promet Resut Opbons Menu jevel:
2 )| Cakarclar HERE ~ ] [ M5T_Diasy I L1 =] Newttom vl |
g Calculator Ba MST_CaLcu
e -
(et ]
| wsentBat,
[ ¥Puln|u =
( Maye tiem... |
-~ l Previaw |

Edit menyu {igin Rezult meydanynda Command diyip
saylamaly we Do Form MITDAU.scx diymeli. Report
menyuda iki Sub menu bar. Bu yagdayda Rezult meydanda iki
yazgy girizmeli yagny, REPORT FORM MITDAU.frx
PREVIEW we REPORT FORM MITDAU.frx TO PRINT.

Exit menyusynda Rezult meydanynda Prosedure
cagyrmaly we ekrana arassalayjy prosedurany girizmeli.

Alnan dialog penjiresi:

e st _Optors  Menujevet
EI'E ” Submerns W | [Edit ] f_‘] “; Moru) Bar -

| E Command D0 FORM saudd
= L
| Report Subwreru —_— =
| B Proceckee [ fwed |
—
Dalate  J
Move bom 4
l o " Prwiow “|
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Taslamanyn bas programmasy seyle bolyar.

Do setup
Do name menu.mpr
Read events

Read events — bu menyu saylanan wagty degisli islerin
yerine yetirilsini lipjiin edydn komanda.
Menyunyii konstruktory tarapyndan doredilen programmany
gormek tigin :

Modify File <menyu faylyii ady> komandany bermeli.
Mysal tigin yokarky doredilen menyunyn kody :

kkhkhkhhhhhkhkhhkhkhrirrrhkhkhhkhkhrirrrhhhhkhkhiriiiiihidhhhiiiix

05/07/04 STUD.MPR 11:20:20

kkhkhkkhhhhkhkhkhkhkhkhhihrrhkhkhhkhkhhirrrhhhhhkhiriiiiihihhhiiiix

* Author's Name

*

* Copyright (C) 2004 Company Name
* Address

* City, Zip

*

* Description:
*This PROGRAM was automatically generated BY GENMENU.

khkhkkhhrhkhkhkhkkhkhkhhirrrhkhkhhhkhirrrrhhhhhkhiirrrhhihhhiiiix

* *
* * Menu Definition
* *

khkhkhhrhhkhkhkhkkhkhirhrrhkhkhkhkhkkhrirrrhkhkhhkhkhirriiiixhhhhiiiix

* DEFINE PAD _s5dOrk!7t OF _MSYSMENU PROMPT
"Service" COLOR SCHEME 3 ;

AFTER _MSYSTEM;

KEY ALT+S,""
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DEFINE PAD _s5dOrk!99 OF _MSYSMENU PROMPT
"Edit" COLOR SCHEME 3;

AFTER _s5dOrk!7t;

KEY ALT+E,""

DEFINE PAD _s5dOrk!9c OF _MSYSMENU PROMPT
"Report" COLOR SCHEME 3;

AFTER _s5dOrk!99;

KEY ALT+R, " "

DEFINE PAD _s5dOrk!9f OF _MSYSMENU PROMPT
"Exit" COLOR SCHEME 3;

AFTER _s5dOrk!9c;

KEY ALT+E,""

ON PAD _s5dOrk!7t OF _MSYSMENU ACTIVATE POPUP
service

ON SELECTION PAD _s5dOrk!99 OF _MSYSMENU DO
FORM Stud

ON PAD _s5dOrk!9c OF _MSYSMENU ACTIVATE POPUP
report

ON SELECTION PAD _s5dOrk!9f OF _MSYSMENU;

DO _sbdOrklaq ;

IN LOCFILE ("\SJM\ STUD", "MPX;. MPR | FXP; PRG",
"WHERE i s STUD ?")

DEFINE POPUP service MARGIN RELATIVE SHADOW
COLOR SCHEME 4

DEFINE BAR _MST_DIARY OF service PROMPT
"Calendar"

DEFINE BAR _MST_CALCU OF service PROMPT
"Calculator™

DEFINE POPUP, report MARGIN RELATIVE SHADOW
COLOR SCHEME 4

DEFINE BAR 1 OF report PROMPT "Preview"

DEFINE BAR 2 OF report PROMPT "Print"

ON SELECTION BAR 1 OF report REPORT FORM scholar
PREVIEW
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ON SELECTION BAR 2 OF report REPORT FORM scholar
TO PRINT
* s5dOrklag ON SELECTION PAD

* *

. * * Procedure Origin:
* %
** From Menu: STUD.MPR, Record: 10
** Called By: ON SELECTION PAD
** Prompt: Exit
*e * Snippet: 1
* %
* PROCEDURE _s5dOrklaq
* NAME EXITMENU
que=MESSAGEBOX(?',33, 'Cykys")
IF que=I
RELEASE WINDOW CALENDAR
RELEASE WINDOW CALCULATOR
CLEAR WINDOWS
SET SYSMENU TO DEFAULT
CLOSE ALL
CLEAR EVENTS
ENDIF

Set system menu to default komandasy Foxpronyn
ulgam menyusyny dikeldydr.

18. SQL talaplaryi dili.

SQL - Structured Query Language — struktirlenen
talaplaryn dili, yagny doredilen talaplaryn {isti bilen tablisalary
we maglumat bazalary derfiemekde ulanyyan programma
serisdesi. Dilifi esasy ayratynlygy, yagny bu dilift komandalary
ayratyn yazgylar bilen islemén, eysem relyasion — bagly
tablisalaryn, yazgylar toplumlarynyn tistiinde islép bilyar.

SQL 1974-nji yylda “IOM” firmasy tarapyndan
doredilen.
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| S T e e ]

Mevdanlarvii tipi Kesgitleyji harp
Character C
Date (D)
DateTime I
Numeric N
Floating F
Integer |
Double B
Currency Y
Logical |
Memo M

Gieneral G

Surat: meydanlaryii tipi

Null ya-da Not Null belgisi degisli meydana
maglumaty yazmagyn rugsadyny beryir ya-da gadagan edyar.
Bar bolan tablisanyn diiziimini programma yoly bilen
iiytgetmek {i¢in asakdaky komanda ulanylyar :

Alter table <tabl.ady>

Add / Alter [COLUMN] <meydan ady>

<meydanyn tipi> [(<6l¢egi> [, <bdlek razryadyn sany>])]
[Null / Not Null]

[PRIMARY KEY | UNIQUE]

[SET CHECK <ailatma 1> [ERROR <anlatma 1>]]

Bu komanda maglumat baza girydn tablisalary
Ozgerdydr, emma tablisanyn i¢i bos bolsa, onda Modify
Structure komandasyny ulanmaklyk amatly bolyar. azgylaryn
dogry girizilydndigini kontrollykda saklayan CHECK
opsiyasydyr. Asakdaky mysalda aylyk haky otrisatel bahany
almaly dél. Eger tersine bolsa, onda habar ¢ykarylyar :

ALTER TABLE;
ALTER COLUMN aylyk haky SET CHECK aylyk haky>=0;
ERROR "Aylyk haky otrisatel bolmaly dal"
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INSERT komandasy tablisany agyar, yazgy gosyar we
sol yazgynyn meydanlaryny VALUES parametrde
gorkezen bahalary bilen dolduryar.

Umumy yazylysy :

INSERT INTO <tabl.ady>
[(<meyd.adyl1>[,<meyd.ady2>[,...]])]

VALUES (<anlatmal>[,<anlatma2>[,...]])

Ya-da

INSERT INTO <tabl.ady> FROM ARRAY <massiwin ady> |
FROM MEMVAR

Mysal :

Insert Into MITDAU (name, phone) Values (‘Berdiyew’ ,
334555);

SQL dilinde 4&hli komandalar talapyin esasynda
isleyarler. Talaby vyasamakda we isletmekde Select
komandasynynn uly orny bar. Select komandasy tablisany
acyar, indeksleri tapyar, maglumatlary toparlayar, hasabata
esas doredyar.

Select komandasynyin umumy yazgysy :

Select [ALL / DISTINCT]

From <magl.bazanyn ady>

JOIN [<magl.baz.ady>]

INTO [< nird >]

No wait

Where [<sert > And [<sert>....]]
Group by [<kolonkalaryn spisogy>]

SELECT komandasynda DISTINCT ulanylsa amatly,
sebdbi bu opsiya gaytalanyan bahalary ayyryar. INTO opsiyasy
talabyn netijesinde saylanan maglumatlary nird ge¢irmelidigini
kesgitleyar.

INTO <ekran>/ TO FILE <faylyn ady>/ TO PRINTER

Talabyn netijesi wagtlayyn buferde QUERY sozbasy
bilen yatda saklanylyar we INTO opsiyanyn komegi
netijesinde gerekli yere iberilyar.
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Mysal : Select ady, talyp-haky From MITDAU Into
MITDAU _haklar

Gosmaca opsiyalar :

PREFERENCE — talabyn netijesinin dasky gorniisini
yatda saklamak iicin Browse penjird
gecrilmeli bolan yagdayynda ulanylyar;

NOCONCOLE — ekrana netijdni ¢ykarmayar;
PLAIN — kolonkalaryn s6zbasysyny ¢ykarmayar;
NO WAIT — programma yerine yetirilip durka

talabyn netijesini gorkezyér.

Talapda saklanylyan maglumatlaryn filtrasiyasy iigin
we talapda birndgce bagly tablisalary bar bolsa WHERE
opsiyasy ulanylyar.

Umumy yazgysy :

Where [< basga tablisa bilen birikmek serti >]

[AND 1 OR <sert> [ AND <sert>]]
Mysal :
Select name From MITDAU Where talyp_haky Between /
300 000 and 2 000 000

Talap yasalanda funksiyalar ulanylyar. Ulanyjylar
tarapyndan doredilen funksiyalar ulanylsa Select komandanyn
isi hayallayar.
Mysal: Uly harp bilen Ady, Atasynyn ady atly sdzbasyda ady
meydanyn yazgylaryny ¢ykarmaly.

Select Upper (ady) AS Ady — Atasynyn ady From
MITDAU

Ulanvlvan funksivalar :

AVG() — orta baha;

AVG (DISTINCT) — gaytalanmayan bahalaryin orta
bahalary;

COUNT () — stittindéki yazgy sany;
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COUNT(*) — talap netijesinde setir sany;

COUNT (DISTINCT) — talap netijesinde meydanyn
diirli anlatmalarynyi sany;

MIN() — stitlindaki in kici anlatma;

MAX() — siitlindéki in uly anlatma;

SUM() — siittinddki san anlatmalaryn
jemi;

SUM(DISTINCT) — sitiinddki san anlatmalaryn,
gaytalanmayan anlatmalarsyz
jemi.

Mysal: In bolmanda bir gezek talyp hakyny alan
talyplaryn spisogy ¢ykarylyar.
Select group, ady, FAM From MITDAU having count
(tdlendi)>1
Update komandasy meydanlara tdze bahalary beryar.
Umumy yazylysy :
Update [<tabl.ady>]
Set <iiygedilydn meydan> = <tZze baha>
[Where <anlatmal> [AND / OR <ailatma2>....]]
Mysal : Talyp haklary 2 000 000 detilemeli.
Update MITDAU
Set talyp_haky =2 000 000
Kéhalatda maglumatlary (konelisen, gerek dil) yok
etmeli. Su yagdayda Delete komandasy ulanylyar.
Umumy yazylysy :
Delete From [<tabl.ady>]
[Where <anilatmal>] [AND/OR <aiilatma2>]
Mysal : Talyp haky =1 300 000 bolanlary yok etmeli.
Delete From MITDAU Where talyp haky = 1 300 000
PACK

Delete komandasy yazgylary yok etmek {igin
kesgitlenen, PACK bellenilen yazgylary doly yoklayar.
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Talabyn netijesi grafika gornilisinde goérmek amatly
bolyar. Grafikany gurmak {i¢in yorite komek¢i komandalar bar.
SQL dilinde gorniis (predstowleniye) doredip bolyar.
Umumy yazgysy:
Create SQL View  [<gOrniisin ady>]
[Connection]
[AS <komanda Select>]
Mysal : topar belgisi 3-den kigi , talyp haky 1 000 000 —
1 300 000 aralykdaky bolan MITDAU we
MOTT tablisalardan talyplaryi adyny saylaly.
Open Database KTU
Create SQL View T,
AS Select ady From MITDAU , MOTT
Where talyp_haky 1 100 000 and 1 300 000 and

group <3

Modify View < gérniisin ady > - emele gelen gorniisi
gorkezyar,

Drop View < gorniisin ady > - gorniisi yok edyar.

19. Visual Foxpro-nyi ulgam funksiyalary
Visual Foxpro-da yygy-yygydan ulgam funksiyalary

ulanylyar (450 sany). Ulgam funksiyalary birnice toparlara
boliinyérler :

- dirli tipli berilenler bilen;

- tablisalar bilen;

- indeksler bilen;

- uytgeyén ululyklar, massiwler, programmalar bilen;

- menyu, ¢ap bilen.
Math — san berilenler bilen isleyan funksiyalar;
String — simwol berilenler bilen isleyan funksiyalar;

70



Date — data, wagt tipli berilenler bilen isleydn
funksiyalar;
Logical — logiki berilenler bilen isleydn funksiyalar.

Matematiki funksiyalar arifmetiki, trigonometriki, finans
gorniislere bolinyarler.

ABS (<anlatma>) — absolyut baha;
AVA(<anlatma>) — orta baha;
CELLING (<anlatma>) — in golay bitin san;
FLOOR (<anlatma>) — in ki¢i bitin san;
EXP (<ailatma>) — natural logorifmiil esasy
Max- in uly san;
Min- in kigi san;
Mod (<aiilatma 1>, <anlatma 2>) — boliinmekde

bitin bdlegi alyar.

Round — tegelekleyar.

SQRT (<anlatma>) — kok asagy;

Sum —jem;

acos(<arnlatma>)

asin (<anlatma>)

atan (<anlatma>)

cos (<anlatma>)

sin (<aiillatma>)

DTOR (<anlatma>) — gradusdan radiona gegyar.

PI()

ALLTRIM (<anlatma>) — dhli probelleri ayyryar.

Len (<anlatma>) — simwol sanyny kesgitleyar.

Replicate (<anlatma>, <anlatma>) — N gezek anlatma c-i
gaytalayar.

CDOW - hepdénin giiniini gorkezyar.

Week () — yylyn bagyndan béri hepde sanyny kesgitleyar.

Kéhalatda ekrana, printere, tekst fayla informasiyalary
c¢ykarmaly bolyar. Maglumaty ekrana ¢ykarmak ii¢in :

@ <y, x> say <anlatma>
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Gerekli pozisiyadan anlatmanyn teksti ekrana c¢ykarylyar.
Mysal :
@ 2.5 say [salam]

Kéhalatda suratlary ekrana ¢ykaryp bolyar.

Mysal : @ 5.5 say Photo center size 25.50

— bu mysalda MITDAU tablisadan ekranyil ortasynda
25.50 dl¢egli photo meydanyndan surat alynyp gorkezilyér.

GET komandasy bahany kabul edip bilydr. Mysal :
Girizilen simwollardan baglanyan atlary tapmaly.

p=>"°
@ 2.2 say ’iki sany birinji simwoly giriziii’ get p
Read
Set Filter to name =& p’
Browse

Set Fliter * tapylan yazgylary gormek.

Maglumatlary printere, tekst fayllara, ekrana hem cap edip
bolyar.

Set decimals to 12

?2*P1 ()

Netije : 6.283185307180.., yagny otyrdan son 12 sany
cykaryar.

? komandanyhn ii¢ modifikasiyasy bar :

? — tdze setirden;
7? — kursoryn duran setirinden;
???  —printere.

Set printer on/off — printere, tekst fayla, porta gegirilip bilner.
Set printer to komandasy goni ekrana maglumatlary
cykaryar. Cap ediji gurlugyn tayyardygyny Print Status
funksiyasy T we F bahalar bilen kesgitleyir.
Set Printer on
In not print status ()
Wait “Printer tayyar dil” window
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Else
Report Format MITDAU to printer
End if
Set printer off

Cetprinter ( ) — funksiyasy ekrany Print atly dialog
penjiresini ¢ykaryar, bu yerde ¢ap draywerini, porty, ¢ap reiki,
kopiya sany, listiii parametrlerini girizip bolyar.

20. Visual Foxpro-nyii prilojeniyalarynyi taslamasy
Taslama maglumat bazalary, tablisalary, das toweregini we
ulanyjynyn interfeysini kesgitleydn esasy programmasy, ekran
formalary, gurallar panelleri we menyulary birikdirydn we her
komponentiii yerlesisini we olaryil dolandyrylmasyny iipjiin
edyar. Taslamanyn diizimi yoriitelesdirilen tablisada .pjX
faylynda yerlesyar. Taslama bilen islenilende ekran formalary,
menyulary, programmalary gozden ge¢irmidge miimkingilik
beryar. Taslama doretmek {i¢in File-New-Project-Newfile-
Create yada Create Project “Taslamanyn ady” komandany
bermeli. Iki yagdayda hem Project Manager penjiresi agylyar,
bu penjirede dhli komponentleri goriip bolyar.

Wkladka Komponentler

All Ahli fayllary gorkezyir

Data Maglumat, baza, tablisalar, talaplar,
proseduralar

Documents Formalar, hasabatlar

Classes Klasslar

Code Programma fayllary

Other Menyu, tekst fayllary, makroslar,
iiytgeyén ululyklar

Project MITDAU
| ALL | DATA | DOCUMENTS | CLASSES | CODE | OTHER |
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+ Data

+Documents

+ yenede gosmaga is diiziimi bar.

Project menyunyn komandasy.

Doredilen yada tidze doredilmeli taslama doredilende we
acylanda esasy menyu project punkty gosulyar we asakdaky
komandalar hodiirlenyér.

Komanda Yerine yetiryiin isi

New file Téze fayl

Add file Fayly gosmaly

Modify file Fayly iiytgetmeli

Preview file Fayly ontinden gormeli

Run file Fayly yerine yetirmeli

Remove file Taslamadan fayly yok etmek
Rename file Fayla tdze at bermeli
Include/Exclude | Taslama girizmeli / girizmeli dil
Set main Bag programmany kesgitlemek
Edit description Redaktirleme orossesleri
Project info Taslama barada maglumat
Bluid Taslamnyn kompilyasiyasy
Errors Yalityslary gorkezmek

Clear Up Taslamany arassalamak

Project information  penjirede dorediji katalog barada
maglumat alyp bolyar we .ico gineldilmeli belgijigi kesgitlap
bolyar. Files atly punktda agsakdaky diiwmeler bar:

Type, Name, Last modified (tipi), (ady), (doredilen wagty)
Project information penjiresi project-project info komandanyn
netijesinde gorkezilydr. Taslama obyektleri gosup bolyar we
ayyryp bolyar. Bas programma project — set main menyusy
bilen kesgitlenydr. Bas programma gerekli bazalary,
tablisalary, zerur fayllary agmaly, ekrany arassalamaly, menyu
fayly ise goybermeli we Read Events komandasyny yerine
yetirmeli. Bu komanda taslamanyn hadysalarynl {istliinde
isleydn mehanizmi aktiwlesdiryér, t4 Clear Events komanda
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berilydn¢d Read Events isldp duryar. Hokmany ¢ykyjy punkt
bolmaly, yagny &hli tablisalar, fayllar, maglumat bazalary
yvapylmaly, ekran arassalanmaly we s.m.

Mysal:

Open Database stud

Clear

Do stud. mpr

Read Events

Close Database

Taslamanyii modifikasiyasy.

Taslamany modifisirlemek ticin modify project <taslamanyii
ady> komandany bermeli yada .pjx degisli fayly agmaly yada
Project Modify file komandany bermeli.

Application Wizard ulanmak.

Bu ussat bilen islemek iigin Tools — wizard — application
komandany ¢agyrmaly.

Taslamanyn ady girizilenden sonra Application Builder dialog
penjiresinde ti¢ gorniislerin biri saylanylyar:

Normal — Visual Foxpro sredasynda ise goyberilyar.

Module — priloZzeniya bar bolan taslama gosulyar, basga
priloZzeniyadan hem c¢agyrylyp bilinyar.

Top level — ayratyn ozbasdak priloZzeniye doredilyér, ol
Windows sredasynda ise goyberilyir.

Application Builder penjiresinin asakdaky wkladkalary bar.

Application Builder

General | Credits | Data | Forms | Reports | Advanced

Common dialog meydanynda asakdakylardan ybarat:

Splash Screen — taslamanyn awtory barada maglumat.

Quick start — taslamanyn boleklerine degisli penjireler
agylyar.

About dialog — About program dialog penjiresi agylyar.

User logins — parol girizmek.
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Icon diiwmini ulanyp doredilydn prilozeniye ii¢in bellik
kesgitlenyar.

Application  Builder-in  data  wkladkasdynda  select
komandasynyn komegi bilen taslamada ulanyljak maglumat
bazalary we tablisany saylap bolyar.

Sofira Form wkladkasyna girip diirli formalary déredip bolyar.
Generate wkladkasynda hasabaty doredip bolyar. Ahli
iytgesmeler we doredilmeli fayllar doredilenden sofira Run
diiwmani basmaly.

21. Obyekte goniikdirilen programmirleménin elementleri.
Obyekte goniikdirilen programmirleménin  tehnologiyasy
programmirlemekde  tdze  wusullary  hodirleyir.Obyekte
goniikdirilen programma 611 doredilen programma modullaryna
esaslanyar. Bu yagdayda taslama tayyarlayjynyn isi
yeinillesydr, tayyar obyektleri ulanmak peydasy yiize ¢ykyar.
Obyekt hokmiinde forma, palitra, tablisa we s.m. bolup biler.
Mysal li¢in agakdaky dialog penjirdni almak {icin komandany
bermeli:

Message box («yaliiys!», 21, «etmeli is»)

Bu komandanyi sintaksisi:

Messagebox (< Bpxx Cl >, <Bpxxk NI1>, <Bpx C2 >, < Bpx
N2 >) nirede:

< Bpxkx CI1 > - dialog penjirede emele geljek teksti ,eger iki
setirde ¢gykarmaly bolsa, onda CHR (13) karetkany ulanmaly.
<Bpx C2> - penjirdnin ady.

< BpX NI> - kodlarynn bahasynyn jemi: yagny
piktogrammalaryn gOrniisi, saylanan diiwmelerin nomeri,
diitwmelerinl toplumy.

Kod | Dialog penjirdnin diwmelerinii toplumy

0 Dinte “OK”

“OK” we “Cancel”

“Abort”, “Retry” we “Ingore”

1
2
3 “Yes”, “No” we “Cancel”
4 “Yes” we “No”
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IE “Retry” we “Cancel”
Kod Piktogrammalar
16 Znak “Stop”
32 ?
48 !
64 Znak “Informasiya”
Kod Saylanan duwme
0 Birinji
256 IKinji
512 Ugiinji

< Bpx N2 > - millisekundta anladylan wagt. Diymek yanky
komanda asakdaky komanda bilen gabat gelyar:
Messagebox (“yalnys!” , 5+16+0, “etmeli is”)
Diiwmeler | Gaytarylyan bahasy
“Ok” 1
“Cancel”
“Abort”
“Retry”
“Ignore”
“Yes”
“No”
Visual Foxpro 8.0 100-e golay wakalary, 100-e golay usullary
we hidsiyetnamalary bar.
Klas diisiinjesi — bu 6z hususy hisiyetler, wakalar, metodlar
bilen kesgitlenyén strukturadyr.
Ahli klaslary iki topara boliinyir:

- Dolandyrys elementleri (diiwme scetcik)

- Elementleri birikdirmek tg¢in konteynerler (forma,

tablisa, gurallar paneli)

N[OOI Wi

Klas ulanmaklyk priloZeniyalaryn programmirleginini tizligini
ulaldyar we programma kodyny gorayar.
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Obyekte goniikdirilen programmirleménin komandalarynyn

sintaksisi.

Kop gabat gelydn wakalar:

Waka Sebibi

Activate Obyekt saylanan we aktiw

Click Cep diiwme bilen obyekte basylan
DonbClick Obyekte iki gezek basylan

Destroy Obyekti yok etmek

Error Obyekt {igin usul yerine vyetirilende

yaliyslyk goyberildi

Kop gabat gelyédn usullar :

Usul Diigtindiris

Close Tables Tablisalary yapyar

CLS Ekrandan grafiki obyektleri we teksti
ayyryar

Move Obyekti gorkezilen koordinatalar
boyunga siiysiiryir

Re fresh Obyektin sekilini tadzeleyar

Kop gabat gelydn hisiyetnamalar:

Hasiyetnama Edyin isi

Active Control Aktiw elementlere yiiz tutmak

Active Form Aktiw forma yiiz tutmak

Alignment Teksti denemek

Auto Center Formanyn ekranyn sentrinde
yerlesdirme

Back Color Obyektin fonunyn renki

Border Style Stil

Comment Obyekte komentariy gosmak

Fill Color Obyektin renki

Fore Color Simwollaryn renki
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Font Bold Galyn tekst

Font Italic Gysardylan tekst
Font Size Olgeg

Height Obyektin beyikligi
Name Obyektin ady

Bir obyekti doretmek mysaly:

Obyekti yada dolandyrys elementi doretmek {i¢in asakdaky
komandany bermeli:

@ Y, X Class <klasyn ady> Name <Obyektin ady>

Mysal iicin stud.dbf tablisada sum meydany boyunca scetcik
doretmeli.

F7 diiwme basylanda GetColor () funksiyanyn komegi bilen
obyektin refikini iiytgedip bilmeli.

Use stud

Clear

On key label F7 — screen page frame 1. Test. Back color=Get
color ()

@ 4,2 Class Spinner Name test

Screen. Page frame 1. Page 1. Test. Control source =
‘stud.sum’

Screen.pageframe 1.page 1. Test.. Height =100

22. Ekran formanyii déredilisi we modifikasiyasy.

Forma — bu 6z icine kébir obyektleri alyan konteyner tipli
wizual obyektdir.

Ekran formasy 6z icine dolandyrma elementlerini saklayar.
Ekran formasy — bu 6zbolusly programma klasydyr. Ekran
formalary Visual Foxpro taslama serisdelerin  komegi bilen
doredilyér.Bu is ligin formalaryii konstruktory ulanylyar.
Formanyn hésiyetnamalaryny bilmek ticin Properts komandany
saylamaly. Properts penjirdniil 5 diiziimi bar:

All — dhli hdsiyetnamalar, usullar, wakalar.

Data — difie maglumatlara degisli hdsiyetnamalar.

Methods — metodlar, wakalar.
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Layout — formanyn dagky gorniisini kesgitleyér.

Other — klaslar, metodlar.

Ug gurallar paneli Layout Toolbar, Form Controls Toolbar,
Color Palette Toolbar forma doéredilende ginden ulanylyar.

Layout gurallar paneli:

Diiwme Isi

Align left sides Cepden den
Align right sides Sagdan den
Align top edges Yokarky aralyk
Align Bottom edges Asaky aralyk
Align Vertical centers Dik orta

Align Horizontal center | Kese orta

Same Height Obyektlerin beyikligi den

Same size Obyektlerin dlgegleri den

Bring to front Hemme obyektleriti  6niinde
goymak

Sent to Berk Hemme obyektlerin  yzynda
goymak

Form
elementleri yerlesdirmek

Controls Toolbar formada dolandyrylsyn standart

ticin niyetlenen.

Sycanynn gorkezijisi islendik diiwmi eltilende onun ady

gorkezilyar.

Diiwme Edyin isi

Select object Dolandyrma elementlerin saylawy

View classes Klas saylawy

Label Yazgy yazmak

Text box Tekst  girizmek  {ligin  meydan
doretmek

Edit Box Tekst we Memo meydanlaryi
doredilsi

Command Button Komanda diiwmesini déretmek

Command Group Bir nice komanda diiwmeli
konteyneri doretmek

Check Box Baydajykly diiwme
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List Box Yazgylaryi toplumyny doretmek
Image Sekil doretmek

Timer Wagt gorkezijini doretmek

Line Liniya doretmek

Shap Goniiburgluk doretmek

Islendik dolandyrma elementi oturtmak ticin Select object
diiwmesi basyyar.

23. Visual Foxpro-nyn klaslary

Visual Foxpro-da klasslaryn ulanylmagy gaytadan
tpjin edyir. Klasslary doretmek {igin Class Designer
(Klasslarynn konstruktory) ulanylyar. Klasslaryn konstruktory
arkaly klass doredilende olar klasslaryn kitaphanasynda .vcXx
ya-da .vct gineltmeli fayl gorniisinde saklanyar. Klasslaryn
tertibi tablisa gorniisinde saklanyar. Bazaly klasslar Visual
Foxpro programmasy bilen bilelikde hodiirlenydr. Her bir
bazaly klasslaryn 6z usullary we hésiyetleri bolyar. Klassyn
hisiyetleri birndge boleklerden duryar:

BaseClass- baza klassyn ady;

ClassLibrary- ulanylyan klassyn kitaphanasynyn ady;

ParentClass- esasy klassyn ady.

Bazaly Kklassdan tapawutlylykda esasy klassyn
hésiyetlerini iiytgedip bolyar, ona tize maglumatlary gosup,
ayyryp bolyar. Seydip esasy klassyn hédsiyetlerine eye bolan
ulanyjy klassyny doredip bilydr. Hagan-da funksiyalar tize
klass doretmekligi talap edydn bolsa, sonda ulanyja klassyny
doretmek amatly bolyandyr. Doéredilen klassyn yazgysy
klasslaryn kitaphanasyna salynyar. Wizual klasslar ulanyjynyn
interfeysini  gurnamak {igin niyetlenen, priloZeniyalarda
funksiyalary we prosesslary dolandyrmak {ii¢in ulanylyar. Onun
mysaly hokmiinde Timer klasy bolup biler.

Microsoft firmasy tarapyndan ondiirlen 100 klasslary 6ziinde
saklayan Foundation Classes kitaphanasy Visual Foxpro-nyn
programmanyn yanynda gelydr. Component Gallery ya-da
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Class Browser penjirelerinddki programma kodlaryny
uytgetmezden klasslary taslamalara, formalara gegirip bolyar.
Klasslar indiki meseleleri ¢ozmeklige komek edyar:

- maglumatlar bazasyny manipulirlemek;

- maglumatlar bazasyna parallel girmek;

- diizedilydn komponentleri doretmek;

- Web sahypalar bilen islemek;

- Windows kitaphanalar bilen islemek;

- diirli utilitalary ulanmak.
Klasslar .vex gineltmeli fayl gorniisinde saklanyar. Birndge
kitaphanalar agcyk bolsa hem, olaryn difie biri aktiw yagdayda
bolyandyr. Formanyn klassynda bir kitaphanany ulanmak tigin

Form Controls gurallar panelinden L belgili View Classes
dolandyryjy elementini saylamaly. Klasslaryn kitaphanasyny
ulanmaklyk ulanyjy iicin programmirlemegi afisatlagdyryar.
Klasslary doretmek.

Ondiirijiligi yokarlandyrmak iicin usullaryf, hisiyetleriii we
ulgam obyektlerinin  dirliligine  seretmezden, ulanyjy
interfeysini hasaba almak bilen bazaly klasslaryn esasynda
usullara we hésiyetlere tdze obyektleri gosmakdan basga-da
taze klasslary doredip bilmek miimkingiligi bar. Bazaly ya-da
esas klassda tdze klassy doretmek {i¢in asakdaky komanda
ulanylyar:

DEFINE CLASS <tize klassyn ady> AS <esasy ya-da bazaly
klassyn ady>

<klassyn hésiyetlerini kesgitlemek>

END DEFINE

Tablisalardan ¢ykylanda, olar iiytgedilende we tablisadaky
yazgylar boyunga gecilende ulanylyan diiwmeleri almak ii¢in
newbtns klassyn doredilsine seredelin. Bu yagdayda bazaly
klass hokmiinde Wizbtns.vcex kitaphanasyndaky txtbtns klassy
cykys edyar. Téze klassy doretmek iigin File menyuda New
komandany saylamaly, agylan penjirede Class opsiyasynda
New File diwmad basmaly. Bu aydylanlary CREATE CLASS

82



komandanyn komegi bilen hem yerine yetirip bolyar. Agylan
New Class penjirede indiki parametrleri kesgitlemeli:

- Class Name- tdze klassyn ady;

- Based On — klassyn adynyn esasynda doredilyan

tédze klass;

- Store In — klassyi saklanyan kitaphanasynyi ady.
Class Name Newbtns hokmiinde kesgitldlin. Bazaly klassy
doretmek tligin Based On penjirdnin sag gapdalyndaky diiwma
basmaly. Agylan Open penjirede Wizbtns.vex kitaphananyn
saklanyan yerini gorkezmeli. ClassName meydanynyn sag
tarapynda sol kitaphanada saklanyan klasslaryn tertibi ¢ykyar.
Ol tertipden Open diwméni basyp txtbtns klassy agmaly.
Téaze klassy wizbtns.vex vya-da newlib.vcx Kitaphanada
saklamak iicin Store In meydanynyn sag gapdalyndaky
ditwmani ulanmaly.

ClassName: | Newtitnas [ (8] 4 l
Enzad On N - E, ::’c:‘ ‘
Fioem: + b makn\program Nles\miczosolt visusl

Stores It Nowit) ]7:

Surat :New Class penjiresi.

OK diiwmesini basyp New Class penjiresinden ¢ykmaly.
Newlib.vcx klassyn we kitaphananyn adyny gorkezydn Class
Designer penjiresi agylyar we standart diiwmelerinn birnédgesi
peyda bolyar. Olaryn birini saylamaly we menyudan
Properties punktyna ge¢meli. Seyle hem diiwmelerin
yerlesisini we olaryn Olgeglerini iiytgedip bolyar. Form
Controls gurallar panelini ulanyp tédze dolandyryjy
elementlerini gosup bolyar. Doredilen standart forma 6ziinde
iki diiwmaéni saklayar. Eger tablisa tize yazgyny gosmak {i¢in
“Add” diiwmesi ulanylyan bolsa, yazgy gosulandan son ol
maglumatlary saklamak iicin “Save” diwmd owrilyar.
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Redaktirlemek {i¢in ikinji “Edit” diiwme “Revert” diiwma
Swrillyar.

Closs . whth, v x {uewhins

[Progertes - aewil oo foewhtoe) - K]

s e s ity St i h o
dria-s < AW
Al | Dats || Methode |j Loyt | Other ED

F AR Y Ko
A dp_ Dol pe ~
Ascbie F. Faen Dalak) B &
£ ack okt zasmms o]
BoseClase [ .
Carvcal . Fales Dalwd om
Claee Caomurd\tir \E m
Closdlbiny v &
Chck £ verd Priveciod tatbine c\up_mae\y EHx
T
Caors 4 - Windows Calots [Defeut) .
(0 !“nl =N AN @
Colost F-Telse Dotodk] R |
i T D == paaa

i T ’

Speciies the taxt dapliged in an cbject’s capton.

~
< y

Surat 2:Class Designer penjiresi.
#DEFINE Add_Caption_Loc "\<Girizmek"
#DEFINE Edit_Caption_Loc "\<Redaktirlemek™
#DEFINE Rev_Caption_Loc "\<Gaytarmak"
#DEFINE Save_Caption_Loc "\<Saklamak™

IF THIS.EditMode
THIS.cmdAdd.Caption=Save_Caption_Loc
THIS.cmdEdit.Caption=Rev_Caption_Loc
ELSE
THIS.cmdAdd.Caption=Add_Caption_Loc
THIS.cmdEdit.Caption=Edit_Caption_Loc
ENDIF
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Setcaption metodyn kody hem navigate metodyn kody yaly
agylyar. Esasy menyu

gosulyan Class menyunyn komandalaryny yerine yetirip
bolyar.

New Property Ady.tipi kesgitlenen tidze hili doredyar.
New Method Ady,tipi kesgitlenen téze usul doredyar.
Edit Property/

Method Hilini ya-da metodyny redaktirleyar.
Include File Fayly gosyar.

Class Info Téze klass barada maglumat hodiirleyar.

New Property komanda dialog penjiresini agyar. Name
meydanynda hésiyetin tdze adyny, Description meydanynda
onun diiziimini yazmaly. Bu hésiyetlere Access we Asign
metodlar elyeter bolar yaly Access Method we Assign
Method baydajyklary gurnamaly. Netijede agzalan metodlar
awtomatiki yagdayda dorediler. Newbtns klassda &hli
tytgetmeleri saklanymyzdan sofi , ony stud.scx formany
modifisirlemek ti¢in ulanyarys.
Kitaphanalar dolandyrylanda seyle operasiyalar yerine
yetirilyar:

- klassyn bir kitaphanadan beylekd nusgasyny almak;

- klassy gosmak;

- klassyn adyny tiytgetmek;

- klassy yok etmek.
Birinji kitaphanadan ikinji kitaphana klassyn nusgasy alnanda
ilki bilen klassy ikinji kitaphana gosyarlar sofira birinjiden yok
edyérler. Kitaphana klassy gosmak indiki komandanyn
esasynda yerine yetirilyar:
ADD CLASS <klassyn ady> OF <birinji kitaphananyn ady>
TO <ikinji kitaphananyn ady> [OVERWRITE]
Klassyn adyny tytgetmek indiki komandanyn komegi bilen
yerine yetirilyar:
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RENAME CLASS <klassyin ady> OF <kitaphananyn ady> OF
<klassyn téze ady>

Klassy kitaphanadan yok etmeklik ti¢in ulanylyan komanda:
REMOVE CLASS <klassyn ady> OF <kitaphananyn ady>
Klasslary wizual dolandyrmak.

Yokarda aydylan klasslar we kitaphanalar bilen gegirilyan
operasiyalary Class Browser-in  komegi bilen wizual
dolandyryp bolyar. Tolls> Class Browser komandany yerine
yetirlenden sofi penjire agylyar.

. newlib.vex (newbtng ) - Class Browser
v| @ @ & 0 W W K
_mé;‘\.\ologr:ﬁ\ﬁfe_;\nﬁ:mmh
B3] « newbins

'\l l':h;c.’ﬁ mwb(ns v > ~ |
|| ParentClass: txtbins
| | (- \xp_main\programtilesSmicrosoft

Surat:Class Browser penjiresi.
Penjirdnin  yokarsynda klassyn we kitaphananyin ady
cykarylyar.

<

Diiwme Operasiya

Component Gallery Komponentlerin ~ galereyasyny
isletmek

Open Kitaphanany agmak

View Additional File Gosmaga kitaphanany agmak

View Class Code Saylanan klassyi kodyny
gorkezyir

Find Program kody gorkezmek
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New Class

Rename

Redefine

Remove

Clean Up Class Library

Téze klassy doretmek
Klassyn adyny calysmak
Baza klassy kesgitlemek
Klassy yok etmek
Kitaphanany yerlesdirmek

Class Browser penjirdnin ¢ep tarapynda kitaphana tarapyndan
saylanan klasslar gorkezilydr, sag tarapynda bolsa klassyn
diiziimi, saklayjylary we metody gorkezilyar. Cep tarapdaky
klasslaryil birinin iistiine baryp sycanyi ¢ep diiwmesini iki
gezek basyp, sol klassy Class Designer —da agyp bolyar.
Penjirdnin sag ya-da cep tarapyndaky obyekti saylap kontekst
menyunyin komandalaryny yerine yetirip bolyar.

Menyunyn komandasy Niyetlenisi
Description Kitaphananyn we klassyi
yazgysyny ¢ykaryar
Always on Top Ondiki planda ¢ylaryar
Auto Expand Klassyn tertibinin  awtomatiki
agylmagy
Parent Class Toolbar Esasy klassy gormeklik
Restore Defaults Diizedisleri dikeltmek
Hierarchical Klassyn tertibini ierarhiki
¢ykarmak
Protected Klassyn goralan komponentlerini
gorkezyir
Hidden Klassyn gizlin komponentlerini
gorkezyir
Empty Klassyil bos komponentlerini gorkezyar
Modify Klassyn modifikasyyasy
Container Icon Klass ii¢in belgini saylamak
Rename Klassyn adyny iiytgetmek
Redefine Baza klass 1¢in ahyrky klassy
kesgitlemek
Remove Klassy yok etmek
View Klassy gormeklik
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Font Klass ii¢in srifti saylamak

OLE Public Miisder tigin serwer klassyn elyeterligi

Select Parent Class  Baza klassy saylamak

New Window Téze Class Browser penjiresini déretmek

New Component Komponentlerin ~ galereyasynyn  téze
penjiresini

Gallery Doretmek

Refresh Class Browser penjiréni tdzelemek

Add-Ins Catylyan komponenti saylamak

Help Class Browser boyunga komekgi penjire

Visual Foxpro-nyn klasslarynda TRY...CATCH...FINALLY
komandalaryn komegi bilen yalityslyklary gaytadan islemek
miimkingiligi bar. Bu komanda seyle gorniisde bolyar:

TRY <yerine yetirlende yaliiyslyk doremek miimkingiligi
bolan operatorlar blogy >

CATCH<eger TRY blokda yaliiyslyk yiize c¢yksa yerine

yetirilyan blok>
FINALLY  <operatorlaryn ahyrky blogy>
ENDTRY

Visual Foxpro-da koponentleriii galereyasy.
Component Gallery — kitaphanalar we Kklasslar, tayyar
taslamalar, tekst dokumentler, Web-sahypalara yiizlenmeler,
formalar yaly lokal we aralykdaky komponentleri 6ziinde
saklayan priloZeniyalary calt isldp diizmek licin Visual Foxpro-
nyn serisdesidir. Komponentlerin galereyasy komponentleri
toplamaga,  tertiplesdirmige,  olaryn = gdzlegini = we
modifikasyyasyny yerine yetirmidge seyle hem olary tédze
komponentler bilen doldurmaga miimkingilik  beryar.
Komponentlerin  galereyasy bilen islemek iicin indiki
komandany yerine yetirmeli:

DO (_GALLERY)
ya-da menyunyn komandasy Tools=> Component Gallery.
Component Gallery penjiresinin ¢ep tarapynda Visual
Foxpro-nyin standart kataloglarynyn tertibi ¢ykarylyar, sag
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tarapynda bolsa ¢ep tarapdaky saylanan katalogynn mazmuny

gorkezilyar.

Standart kataloglar
Catalogs

Favorites

ActiveX Catalog

My Base Classes
Visual Foxpro Catalog

Visual Foxpro Samples
Mulrimedia Catalog

World Wide Web

Mazmuny

Ahli kataloglar

Ko6p ulanaylyan obyektler
ActiveX-in bellige alnan
obyektleri

Baza klasslar

Berlenler bilen islemek
i¢in Data kataloglar
we Table Wizard
masterler; esasy klassly
Foundation Classes;
ReadMe  yaly klassly
Help; forma, sablon
doretmek ticin Templates;
kalkulyator we gosmaca
gurally Tools paneli.
Tayyar mysallary

Saz ya-da wideo
obyektleri saylamak
Web-sahypalaryn
salgylarynyn tertibi

Asakdaky suratda Component Gallery penjiresinini ¢ep
tarapynda Catalogs katalogynda New Application belgisi bar.
Ol saylananda doredilyédn taslamanyn duryan yerini we adyny
kesgitlemek ticin Application Wizard penjiresi agylyar.
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¥ Application Wizard

qugctlie,

T |

0 Create project drectory stiucture

. 0Add to Favorites catalog [ ————Jm

Surat :Enter Project Name penjlre3|

ft Catalogs - Component Gallery e l@m”:_gl
& | Defaut ~ % ZIE #Mss 0 iEE:fﬂ
& Catalogs
@2 Favorites
= @ACWQX Catalog ActiveX My Base
+ {13 Contrals Controls
[£1 Sewvers
R ® @
My Base Classes
E Visual FoxPro Catalog VFPMain  Worldwide Samples
% {21 Data Web
{13 Foundation Classes B
+ [ Templates =
1 Tools . New

Surat:Component Gallery penjiresi.

Eger Add to Favorites catalog-da baydajygy gurnasak, onda
doredilen taslama Favorites katalogyn iistini dolduryar.
Komponentlerin galereyasynyi gurallar paneli.

Component Gallery penjiraninn gurallar paneli 6ziinde Class
Browser di}’/f:_t_l diiwmaéni saklayar. Open diiwmesi dialog

penjirdni agyar. e,
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2% Select an existing catalog description or file name, and

'3 Component Gallery will open it for you.

[t MY B aseClaseae

DAdd catalog toACL-:;r‘ent defauk view
i Open jL Canod—] Uirowse.j

Surat :Open penjiresi
Find diiwmesi komponentleri gézlemek ii¢cin ulanylyar. Mysal
ticin asakdaky suratda kalkulyatory gozleyin Find Component
penjiresi gorkezilen.

11 Find Component

Contanng: | caleulatol ]
looki: {(MCatdogsh ¥ [Cacd ]
Kewords: | i (2] [ NewSeach]
..Search fields: ltem types; ————-- - Resultview: ——
| Dtenrane OCoroge | US| | oo 1
 @lRescriion [IPropeties | (e 8
- ClFtename ; Datasource l

i 8

Surat :Find Component penjiresi
Up One Level diiwmesi kataloglar goriilende bir dereje yokary

galmak ii¢in nieyetlenen.[@ Large Icon, Small Icon, List we
Details diiwmeleri katalogyn mazmunyny diirli rezimlerde
gormek ii¢cin niyetlenen. Komponentlerin galereyasyny diizmek
ticin Component Gallery Options penjiresini agyan Options
diiwmesine basmaly.®8. Ol birndce boleklerden duryar:
Catalog — komponentlerinn galereyasyna tdze komponentleri
gosmak iicin; Dynamic Views - hodiirlenen berlenleri yok
etmek, gosmak, tytgetmek; Standart — diizedislerin umumy
parametrlerini kesgitlemek.

Komponentleriii galereyasyny ulanmak.
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Component Gallery penjiresi Default rezimine gabat
gelyar. Ondan bagga-da agylyan tertipde tipi boyunca
toparlanan klasslary ¢ykarmak iicin Class by Type rezimi,
Internetde islemek {i¢in niyetlenen  klasslary ¢ykaryan
Internet  rezimi, formany calt gurnamak {i¢in niyetlenen
klasslary ¢ykaryan Fast Form rezimi bar. Mysal ii¢in Class
by Type->Button saylananda penjirdnin sag tarapynda Simple
Navigation Buttons esasy klassyn belgisi ¢ykyar. Ol tablisada
one, yza gegmeklik iicin iki diiwmeden ybarat bolan konteyneri
doredyér. Seyle obyekti gormek we modifisirlemek {i¢in
menyudan Modify komandany saylamaly we obyektin
belglsmde sycanyi gep diiwmesini iki gezek basmaly

Q'G”SWTM &9
&) ActweX ?
(34 Buttons Sinols
8 Buton Navigali.,
&3 Gstom
&) Containee
(8 Combobons View in frowser
& Contid
50 Fouma
el Usts View Sample  »
24 Labels
(41 Yoobars teb.
‘ Lopy
| e Remove ===
Aset lmm«;mmmnrd&qwnauhwmsb Rename ~
- =1 Pvcc»:«ies s W i

Su rat Duwmelerm klassyny saylamak

Esasy klassyn metodlaryny we hésiyetlerini kesgitlemek we
Form Controls gurallar panelinin komegi bilen formany
modifisirlemek tigin Klassyi konstruktory penjiresi agylyar.
Saylanan klassynl metodlaryny we hésiyetlerini gérmeklik {i¢in
Class Browser penjiresinin menyusyndan View in Browser
komandany  saylamaly. Penjirdnin ¢ep  tarapynda
_nav2butttons konteyner bolyar, sag tarapynda bolsa onun
obyektleri we metodlary yerlesyar.
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table,vex( navZbuttons) - Class Browser

B 2000 V@™ E AW %
[ ||\xp main\gwogran fles\microsolt | - Obects
B - Pedialog B  cmgnav [Commandsroup)
B < ooy v custablenay (Custom)
- < fndbutton > Methods
B _fndoehutions 4 lablanay
h B - _inddalog 99 ° lopcle_sccess
B « gotoduiog 9" lopde_astign
-8 - Propedes
B _nevibuttons ¢ loxck
- R < _toble
W lablelind
W _tablenay
v _lablesert
< D) 3
| Gass: _nav2ixstons .
|P.-nﬂur cortaner ﬁ\:o_m.v\aowmlm\-nucﬂ
vised oo SUIC\_base. vex v

Surat: Obyektiii metodlaryny we hésiyetlerini gormek.

Islendik metodyn kodyny hem goriip bolyar. Sycanyn cep
ditwmesi bilen tablenev metodynyn dstiinde iki gezek
basylanda indiki kody gérmeklige miimkingilik beryér:
LPARAMETERS tcAction

IF EMPTY (tcAction) OR VARTYPE(tcAction) # "C"
RETURN

ENDIF

DO CASE

CASE UPPER (tcAction) ="NEXT"
THIS.cusTableNav.GoNext()

CASE UPPER (tcAction)="PREVIOUS"
THIS.cusTableNav.GoPrevious()

OTHERWISE

ENDCASE

Bu kod Next diiwmesi basylanda GoNext() metodynyn
isleydndigini anladyar. Bu metody gormeklik iicin penjirdnin
¢ep tarapynda tablenav obyekti saylamaly, sag tarapynda
gonext metodynyn kodyny agyp goriin:

LOCAL IcAlias
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IcAlias=THIS.GetCurrentAlias()
IF THIS.CurrentTableAllowsNavigation(IcAlias)
SKIP IN (IcAlias)

IF EOF(IcAlias)

SKIP -1 IN (IcAlias)

IF THIS.ICycle
THIS.DoCycleTopMessage()
THIS.GoTopO
THIS.RefreshUlAfterChange()
ELSE
THIS.DoBottomMessage()
ENDIF

ELSE
THIS.RefreshUlAfterChange()
ENDIF

ENDIF

Modifikasiyalar yerine yetirlenden son obyekt forma,
taslama ya-da Visual Foxpro penjiresiniii esasyna gegirlip
bilner. Form Designer we Project Manager penjireleri gérner
yaly ilki bilen Component Gallery penjiresinin 6l¢egini
kigeldin. Component Gallery penjiresininn ¢ep tarapynda
saylanan obyektint {istlinde sycanyn c¢ep diiwmesini basyp
saklap ony gerekli yere gecirmeli. Asakdaky suratda Visual
Foxpro-nyn “KonctpykTop ¢opm” penjiresine obyektii

gecirilsinin netijesi gorkezilen.
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Surat : Proyektirlenen forma obyekti gecirmek.

Seyle usul bilen komponentlerit  galereyasynyi
mimkingiliklerini ulanyp ko&p funksiyaly prilozeniyalary
doredip bolyar.

24. Visual Foxpro-nyii tor ara ulanylsy
Ulanyjylar Visual foxpro-nyn kép komponentlerini lokal we
global torlarda ulanyp bilyirler. Bu boélimde maglumatlar
bazalarynyn lokal torlarda islemeklik miimkingliliklerine
seredilydar. Serwer lokal torun diwiini bolan serwer
maglumatlar bazalaryny we olaryi indekslerini dolandyrmak
tigin ulanyar. Bu yagdayda Visual Foxpro_ny isjen stansiyada
ya-da serwerde yerlesip bilyar. Administrator tarapyndan her
bir ulanyja Visual Foxpro girmeklik rugsat edilyar. Visual
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Foxpro torda wulanylanda esasy mesele ulanylyan
maglumatlaryn bitinligini  saklamak bolup duryir. Bu
meseldnin ¢oziilmegi ii¢in torda maglumatlaryn blokirowkasy,
buferlenmegi we tranzaksiyasy gecirilyar.

Maglumatlaryn blokirowkasy.

Maglumatlary birndc¢e ulanyjylar birwagtda ulananda
doreydn kyngylyklaryny ayyrmak {igin maglumatlaryn
blokirowkasyny ulnmaly bolyér. Blokirowka is tamamlananda
ya-da ulanyjynyn yerine yetirmegi tarapyndan ogiirlip bilner.
Tablisalar, sozbasylar we ayratyn yazgylar blokirlenip bilyar.
Blokirowkany agyk ya-da onden blokirlenen tablisada gurnap
bolmayar. Eger tablisanyn sozbasy blokirlenen bolsa, onda
onun yazgylary beyleki ulanyjylara dine redaktirlemige
miimkingilik berilydr, tablisalary gosmak we yok etmek rugsat
edilmeyar.

Programma blokirleme.

Maglumatlary kop ulanyjylar tarapyndan ulanmaklyk
miimkingiligini agakdaky komanda kesgitleyar.

SET EXCLUSIVE ON | OFF

Adatga SET EXCLUSIVE ON | OFF gurnamasy ulanylyar.
Tablisalary bu reZimde ag¢maklyk difie ony acgan ulanyja
miimkindir. Dine su rezimde indiki komandalary yerie yetirip
bolyar: MODIFY STRUCTURE (diiziimii modifikasyyasy),
REINDEX (reindeksirleme), PACK (yerlesdirme) we ZAP
(arassalama), seyle hem INSERT [BLANK] (tablisa yazgylary
goymak). Tablisa iicin yokardaky komandalaryn biri yerine
yetirlende ulgam fayly agmak barada habary ekrana g¢ykaryar:
"Exclusive Open of File Required".

Monopol rezimde tablisany a¢mak {i¢cin USE stud
EXCLUSIVE ya-da SET EXCLUSIVE ON USE Stud
komandalar ulanylyar. Bu komandalardan sonn SET
EXCLUSIVE OFF gurnama yerine yetirilse stud.dbf tablisa
blokirlenen yagdayda bolyar, yone tablisa yapylandan son
blokirlenme ayrylyar. Tablisanyn blokirlenendigini gérmek
ticin ISFLOCKED() funksiyasy ulanylyar. Birndge tablisalaryn
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arasynda SET RELATION komanda arkaly baglansyk
gurnalan bolsa, her baglangylan tablisalary blokirlemeli.
Gorkezilen tablisalary ya-da yazgylary blokirlemek ii¢in
asakdaky funksiya yerine yetirilyér.
LOCK([<isjent meydan >|<tablisanyn ady>]
[<yazgylaryn nomeri>,<igjen meydan>|<tablisanyn ady>]])
ya-da
RLOCK([<isjen meydan>|<tablisanyn ady>]|
[<yazgylaryn nomeri>,<igjeii meydan>|<tablisanyn ady>])
Eger bu opsiya ulanylmasa, onda aktiw isjeii meydanyndaky
yazgy blokirlenyir. Yazgylaryii toparyny blokirlemek
asakdaky komandanyn iisti bilen amala asyrylyar:
SET MULTILOCKS ON | OFF

Blokirlenydn yazgylaryn nomeri LOCK() ya-da RLOCK()
funksiyalaryn  komegi  bilen amala agyrylyar. SET
MULTILOCKS ihli agyk tablisadaky blokirlenen yazgylardan
blokirlenmédni ayyryar. Basga ulanyjy tarapyndan blokirlenen
tablisany ya-da onun yazgysyny a¢maklygynl sany we
yzygiderligi
SET REPROCESS TO <kesgitlemeNe> [SECONDS] | [TO
AUTOMATIC]
komanda arkaly kesgitlenydr. <kesgitlemeN> SECONDS
opsiyasy ulanylanda agmaklygyn sanyny ya-da wagtyny
sekundlarda kesgitleyar we 0 — 32000 aralygynda yerlesyr.
Adatga  <kesgitlemeN>=0. Tablisanyn blokirlenmeginin
gezekleriniii arasyndaky wagt interwaly SYS(3051) funksiya
arkaly kesgitlenyir. Yazgynyi blokirlenendigini bilmek iigin
ISRLOCKED() funksiyasy ulanylyar. Su maksatlar {icin
SYS(2011) funksiyasyny hem ulanyp bolyar. Tablisanyn
blokirlenmesini ayyrmak {iicin blokirlenmdni goyan ulanyjy
indiki hereketleri birini yerine yetirmeli:
- ulgamdan ¢ykmak(QUIT komandasy);
- tablisany  yapmak(CLOSE ya-da CLOSE ALL

komandasy);
- tablisanyi yazgysyny acmak;
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-  UNLOCK [RECORD <yazgynyn nomeri>][IN
<ady>][ALL] komandany yerine yetirmeli.

UNLOCK komandasy tablisanyi we onuni yazgylarynyn

blokirlenmesini ayyryar. ALL opsiyasy dhli agyk tablisalaryn

blokirlenmesini ayyrmak ti¢in ulanylyar. RECORD() opsiyasy

dine gorkezilen yazgyny agmaklyk iicin ulanylyar. Birndge

tablisalaryi arasynda baglansyk gurnalan bolsa, her tablisa iigin

blokirlenméni ayyrmaly bolyar. Blokirlenméni ayyrmagyn we

gurnamagyn mysaly:

SET EXCLUSIVE OFF

SET REPROCESS TO 3 AUTOMATIC

USE stud

? ISFLOCKEDO

* F.gaytaryp beryir

? ISRLOCKEDO

* F. gaytaryp beryir

? FLOCK()

* tablisa blokirlenyir we .T. gaytaryp beryir

? LOCK ("5", "stud™)

* 5 nomerli yazgy blokirlenyir we .T. gaytaryp beryir

? ISRLOCKEDO

* .T. gaytaryp beryir

? ISFLOCKED()

* F. gaytaryp beryir

IF FLOCK()

REPLACE ALL debt WITH debt-(sum/2)

* tablisalar bilen islemeklik

MESSAGEBOX( "korreaksiya yerine yetirildi!")

UNLOCK IN "stud"

* blokirlenme agylyar

EXIT

ELSE

WAIT "Tablisa blokirlenen!" WINDOW NOWAIT

ENDIF
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Awtomatiki blokirlenme.

Maglumatlaryin  awtomatiki  blokirlenmesi tablisa
maglumatlaryna  tytgesme girizilende amala asyrylyar.
Blokirlenen tablisany a¢maklyk ticin bu hereketler yerine
yetirlende seyle habar ¢ykarylyar: "File must be opened
exclusively". Beyleki komandalar yerine yetmezinden 6i1 &hli
tablisanyn ya-da onun yazgylarynyn blokirlenmegi bolup

gecyar.

Komanda Blokirlenyén obyekt

ALTER TABLE Tablisa

APPEND Tablisanyn sdzbasy

APPEND BLANK Tablisanyn s6zbasy

APPEND FROM Tablisanyi sozbasy

APPEND FROM ARRAY  Tablisanyn sozbasy

APPEND MEMO Sonky yazgy

BLANK Sonky yazgy

BROWSE Baglanan meydanlardaky
yazgylar

CHANGE Baglanan meydanlardaky
yazgylar

DELETE Tablisa ya-da yazgy

DELETE(SQL) Sonky yazgy

EDIT Baglanan meydanlardaky
yazgylar

GATHER Sonky yazgy

INSERT Tablisa

INSERT(SQL) Tablisanyn s6zbasy

MODIFY MEMO Sonky yazgy

READ Baglanan meydanlardaky
yazgylar

RECALL Tablisa ya-da yazgy

REPLACE Tablisa ya-da yazgy

SHOW GETS Baglanan meydanlardaky

yazgylar
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TABLE UPDATE() Tézelenenddki yazgylar
UPDATE Tablisa
UPDATE(SQL) Tablisa

Work Area Properties dialog penjiresinden peydalanyp
blokirlenmanin  tipini  kesgitldp  bolyar. Onun iigin
Window-> DataSession komandany yerine yetirmeli we tablisa
saylanandan soni Properties diiwmesine basmaly.

Lock Records-yn c¢édginde vyazylanda (When written) we
redaktirlenende(When edited) yazgylaryn blokirlenmesini berip
bolyar.

Buferleri ulanmak.

Ulgamyn c¢esmelerini optimal ulanmak {i¢in we tora
yiikklenmegi azaltmak ti¢in buferlenme ulanylyar. Buferlenme
yagdayynda girizilen liytgesmeler gaty diskde ya-da operatiw
husda degisli komanda berilydnga saklanyarlar. When edited
gurnawynda yazgy redaktirlenende blokirlenyar, When edited
gurnalanda bolsa yazgy gecirlende blokirlenyar.

Visual Foxpro-da buferlemegin iki usuly ulanylyar:

- dine bir sany sofiky yazgy buferlenyir(Current record).
Beyleki ulanyjylar tablisanyii galan yazgylaryna girmeklige
rugsat alyarlar.

- Dine tablisa buferlenyér(All edited records). Bir wagtyn
0ziinde birnice yazgylar ya-da tablisalar buferlenyar.

Buferlemegii rezimi Buferlemegin hisiyetnamalar
1. Buferlemek ulanylmayar
2. Yazgylaryii umytsyz buferlenmegi
3. Yazgylaryi umytly buferlenmegi
4, Tablisanyn umytsyz buferelenmegi
5. Tablisanyn umytly buferlenmegi

100



Options dialog penjiresinin Data boliiminde buferlemegin
rezimini gurnap bolyar. Ondaky tertipden indiki usullaryn
birini saylamaly: Buffering: Off (Buferlenme yok), Record

Pessimistic (Yazgynyi umytsyz buferlenmegi),
umytly  buferlenmegi),

Optimistic
Optimistic

(Yazgynyh
(Tablisanyn

umytly

Pessimistic (Tablisanyn umytly buferlenmegi).

Aegund
View | Genenad D88 | Pemote Dty | Fié Locesons | Farre Doty

Dty

] Qpen axcrene
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SN Comparaon
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Table ratesh rercs (9t 5

Locang and g
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A A—— S ———— |

Surat:Options

Isin ahyrky seansynda buferlemeginl reZimini kesgitlemek {i¢in
Work Area Properties dialog penjiresinden peydalanyp bolyar.
Eger buferlenme rugsat edilen bolsa, Enable data bufering-de
baydajyk goyulyar. Current record gurnalanda bufere dine
ahyrky yazgy yiklenyér, All edited records gurnalanda &hli
redaktirlenydn yazgylar bufere yiiklenyir. Buffer Mode-da
hésiyetleri kesgitlemek {i¢in tdze formany doredint we kontekst
menyuda Properties punktyny saylamaly. Buffer Mode
formanyn hésiyetleri ti¢ kesgitleménin birini kabul edyar.
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Buffer Mode hésiyetin Buferlemegin rezimi kesgitlemesi

0 Maglumatlary formada gériinyén
tablisanyi yazgysy

1 Umytsyz buferlenme

2 Umytly buferlenme

Formanyn meydanynda Buffer Mode Override hasiyetleri
kursor ti¢in kesgitldlin. Onun {i¢in formanyn kontekst
menyusynda Data Environment komandany saylan. Payment
tablisany meydana gosun we Properties penjire bilen islemek
ticin kontekst menyudan peydalanyi.

Buffer Mode Override héasiyetinde gerekli kesgitleméni
tapyn we ony gurnan.

Buffer Mode Buferlemegii hiisiyetiniii bahalary
Override

0 Buferlemek ulanylmayar

1 Buffer Mode formanyti esasynda buferleme

amala agyrylyar

Yazgylaryi umytsyz buferlenmegi
Yazgylaryi umytly buferlenmegi
Tablisanyii umytsyz buferlenmegi
Tablisanyn umytly buferlenmegi

abbwnN

-  TABLEUPDATE(). Gorkezilen isjen meydanyn, kursoryn,
tablisanyn ya-da yazgynyn buferlenmegini bes edyar.

- TABLEREVERT(). Uytgemeleri kabul etmeyir. Lokal
tablisalar we kursorlar icin maglumatlary dikeldyar.

- CURVAL().Tablisanyn meydanynyn bahasyny gaytaryp
beryir. Bu baha OLDVAL(). Funksiyanyn gaydyp beryin
bahasy bilen detiesdirmek iicin ulanylyar.

-  GETFLDSTATE(<meydanyin ady>). Sanly bahany

gaytaryp beryir.
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Gaytarylyan san | Yok etmegiii hiziyeti ya-da meydanyi
bahasy

Uytgedilmedi

Uytgedildi

Gosulan yazgyda iiytgedilmedi

Gosulan yazgyda tiytgedildi

ZIDhwN-

ULL Faylyn sofiuna yetende

Tranzaksiya.
Tranzaksiya — bu maglumatlaryn biitinligini saklamak {i¢in
ulanylyan serisdelerin  biri. Hereketlerin  yzygiderligini
operatiw husa ya-da diske yazyp alyan hereketlere tranzksiya
diyilydr. Ol maglumatlar .dbf, .fpt, .cdx gifleltmeli fayllarda
saklanyar. Visual Foxpro-da tranzaksiyalary elde dolandyrmak
maglumatlar bazasyna girydn tablisalar {gin elyeterlidir.
Serwer maglumatlar bilen islemek {ii¢in islendik komanda
ayratyn  tranzaksiya  yaly  bellige alyar. BEGIN
TRANSACTION komandasy tranzaksiyany ROLLBACK ya-
da END TRANSACTION komandasyna ¢enli dowam edyar.
Tranzksiyada wagty tygsytlamak {icin her yazgylaryn ayratyn
tranzaksiyasyny gecirmeli bolyar. Tranzaksiyalar bds derejd
cenli dowam edip bilydr. Bu yagdayda olaryn hersi BEGIN
TRANSACTION komanda bilen baglanmaly. TXNLEVEL()
funksiyasy tranzaksiyalaryn derejesiniii sanyny gorkezyar.
Tablisalar tdzelenende ulanylyan tranzaksiyalar asakda
gorkezilen:
CLOSE ALL
OPEN DATABASE stud
USE stud
BEGIN TRANSACTION
REPLACE ALL debt WITH debt-(sum/2)
BROWSE
IF MESSAGEBOX("Uytgemeleri galdyrmalymy?", 36) =6
END TRANSACTION
ELSE
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ROLLBACK

ENDIF

Tranzaksiya yerine yetirlende doretmegin, modifisirlemegin,
triggerlerin  komandalaryny we CLOSE ALL, CLOSE
DATABASE, CLEAR ALL komandalaryny ulanyp bolmayar.
Seyle hem tranzaksiya gecirilydn tablisada indeksirleme,
modifisirleme we doretmek komandalaryny ulanyp bolmayar.
Ulgamda bir ulanyjy islinde fayllara bolek girmekligin
zerurlygy yok. Yéne kop ulanyjylar bolup islenende fayllara
girmekligi bolmek zerurlygy yiize ¢ykyar. Maglumatlar
bazasyny dolandyryjy tor ulgamlary islenip diiziilende birnice
ulanyjylaryn bir wagtyn 6ziinde fayllar tiytgedilende doreyéin
kyngylyklary ¢6zmekligi amala agyrmalydyr. Visual Foxpro bu
kyneylyklaryn  ¢oziiwinin  birndge usulyny hodiirleyér.
Tablisanyn yazgylaryna girlende blokirleme prossesi
ulanyjylara blokirlenen meydany iiytgetmdge miimkingilik
bermeyar.

Blokirleménin gorniisleri.

Visual Foxpro-da blokirleménin iki usulyny ulanyp
bolyar: tablisanyn we yazgylaryin blokirlenmesi. Tablisanyn
blokirlenmesi  ulanyjylara tablisanynn &hli  yazgylaryna
girmekligi gadagan edyir. Yazgylaryii blokirlenmesi yazgyny
iytgetmegi blokirleme goyan ualnyjydan basga ulanyjylara
rugsat bermeyir. Yazgylaryii blokirlenmesini ulanmak amatly
boldr, sebdbi ol belli gorkezilen tablisanyil yazgylaryny
blokirlemége miimkingilik beryir.

Awtomatiki blokirleme.

Visual Foxpro-da blokirleme elde goymak we awtomatiki
usulda amala agyrylyar. Kesgitlenen komandalar ulanylanda
Visual Foxpro tablisany ya-da yazgyny awtomatiki blokirleyar.

Komanda Blokirlenyéin element
ALTER TABLE Ahli tablisa
APPEND Ahli tablisa

APPEND BLANK  Tablisanyn sozbasy
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APPEND FROM
APPEND FROM ARRAY
APPEND MEMO
BLANK

BROWSE

CHANGE

DELETE

DELETE NEXT 1
DELETE <N>

DELETE RECORD <N>
DELETE SQL

EDIT

GATHER

INSERT

INSERT SQL

MODIFY MEMO

READ
RECALL
RECALL NEXT 1

RECALL RECORD <N>
RECALL <n>

REPLACE

REPLACE NEXT 1
REPLACE RECORD <n>
SHOW GETS
TABLEUPDATE()

Ahli tablisa

Tablisanyn s6zbasy

Sonky yazgy

Sonky yazgy

Baglanan tablisalardaky yazgylar
Baglanan tablisalardaky yazgylar
Sonky yazgy

Sonky yazgy

Eger n>1 bolsa &hli tablisa
blokirlenyar

n yazgyny awtomatiki blokirleyar
Sonky yazgy

Baglanan tablisalardaky yazgylar
Sonky yazgy

Ahli tablisa

Tablisanyi sozbasy

Yazgy redaktirlenende
awtomatiki blokir-r

Sonky yazgy

Sonky yazgy

Gorkezilen yazgyny awtomatiki
blokirleyar

n yazgyny blokirleyar

Eger n>1 bolsa &hli tablisa
blokirlenyar

Sonky yazgy

Gorkezilen yazgy blokirlenyér

n yazgyny blokirleyir

Sonky yazgy

Ahli tablisany

Tablisanyn doly blokirlenmesi we blokirleméini iiytgetmek.

Mysal iicin maglumatlaryn gurlusy tytgedilende
tablisanyft doly blokirlenmesi amala asyrylmalydyr. Su
yagdayda beyleki ulanyjylara gorkezilen tablisanyn gurlusyny
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liytgetmek, okamak, yazmak gadagan edilyér. Tablisany doly
blokirlemek reziminde ag¢mak t¢in SET EXCLUSIVE ON
komandasy ulanylyar. Bu komanda yerine yetirlenden son dhli
acylan tablisalar doly blokirleme reziminde bolyar. Doly
blokirleme rezimini ayyrmak ti¢in SET EXCLUSIVE OFF
komandasy ulanylyar. Bu komanda ulanylandan son
tablisalaryin doly blokirlenmesi olar yapylandan soni amala
agyar. Ayratyn tablisany doly blokirlemek {i¢in tablisanyin USE
komandasynyn EXCLUSIVE opsiyasy ulanylyar. Asakda doly
blokirleméni yerine yetirmegin birndge mysallary getirlen.
Birinji mysalda iki komanda ulanylyar.

Tablisanyn blokirlenmesi.
Tablisada blokirlenmegi goymak ticin FLOCK funksiyasy
ulanylyar. Ol indiki gérniisde bolyar:
FLOCK ([isjent meydan] [tablisanyn ady])
Blokirleyji funksiya igjet meydanyn ya-da tablisanyn statusyny
barlayar. Testil esasynda tablisa blokirlenmedik bolsa, ol
blokirlenydr we ulanyjy isini dowam etdirip bilydr. Beyleki
ulanyjylara maglumatlar  bazasy difie okamaklyk rugsat
edilydr. Asakda getirlen mysalda customer tablisany
blokiremek ii¢in FLOCK komandasy ulanylyar. Eger tablisa
blokirlense REPLACE ALL komandasy onufi yazgylaryny
tazeleydr. Ondan son UNLOCK komandasy blokirleméni
ayyryar. Eger fayl blokirlenmese yaliiyslyk barada habar
cykarylyar.

Tablisalardan we yazgylardan blokirlemiini ayyrmak.
Adatca bir yazgydan beyleki yazga gecende blokirlenme
ayrylyar. Eger yazgy blokirleme komandalary blen blokirlenen
bolsa, onda ony blokirleméni agyan komandalar bilen agmaly.
Ol komandalar asakdaky tablisada getirlen.

Komanda Yazgysy
CLOSE Tablisalarda  we  yazgylarda
blokirleméni ayyryar
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CLOSE ALL Tablisalarda  we  yazgylarda
blokirleméni ayyryar

END TRANSACTION Ahli gurnalan awtomatiki
blokirleméni ayyryar

QUIT Tablisalarda  we  yazgylarda
blokirleméni ayyryar

UNLOCK Isjen meydanyndaky tablisalarda
blokirlemani ay-r.

UNLOCK ALL Isjen meydanyndaky tablisalarda
blokirleméni ay-r.

USE Tablisalarda  we  yazgylarda

blokirleméni ayyryar
SET MULTILOCKS OFF Téze blokirleme doredilende
onkini ayyryar

FLOCK() Fayl blokirlenmezden on
yazgylaryn blokir-ni a-ar.
TABLEUPDATE() Tablisany tdzelemezden on ahli

blokirlemeleri ay-r.
Tablisalaryn we yazgylaryin blokirlenmesini ayyrmak {i¢in
adatca UNLOCK komandasy ulanylyar:
UNLOCK [RECORD yazgynyn nomeri] [IN < igjenn meydan|
tablisanyn ady! >] [ALL]
UNLOCK komandasy parametrsiz gorkezilende sonky
yazgynyn we tablisanyn blokirlenmesini ayyryar. Tablisanyn
blokirlenmesi ayrylanda RECORD opsiyasy ulanylmayar.
Agyk tablisalaryn &hlisinin blokirlenmesini ayyrmak ti¢cin ALL
opsiyasy ulanylyar.

Visual Foxpro-da koép ulanyjylar bilen islemek {igin
maglumatlar bilen iglemekligin seansyny ulanmak amatlydyr.
Onun kdmegi bilen bir formany birndge stansiyalarda ya-da bir
kompyuterde bir wagtyn oziinde acyp bolyar. Bu yagdayda
olaryn hersi maglumatlaryn ayratyn nusgasyny ulanyar.
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25. Visual Foxpro-nyn ulgam miimkingilikleri
Visual Foxpro-da uly géwriimli maglumatlary analizirleméige
giiycli miimkingilikleri bar, bulara mysal edip diagrammalary
we kesisme tablisalary mysal getirip bolar. Maglumatlary
diagramma we grafik gorniisinde gormek diirli meseleleri
cozmége yardam berydr. Diagrammalarda dirli gatnasyklar
diirli prosseslerin arabaglanysygy, Osiisi goriinyar. Adaty bolsy
yaly tablisalar diagramma bolar yaly tayar dil, bu tablisalaryn
esasynda gurnalan diagrammalar diigniiksizrdk bolyarlar, su
sebdpli diagramma gurlup baslanmanka ilki bilen yerlesyin
maglumaty diagramma gurnap bolar yaly goérniise getirtmeli.
Visual Foxpro-da bu is iigin kesisme tablisalar we netijeli
talaplar ulanylyar. Kesisme tablisa — bir yada bir nige
meydanlarynn esasynda toparlanan  maglumatlardyr. Visual
Foxpro-da diagramma gurnamak ftg¢in  Microsoft Graph
komekgisi uylanylydr. Visual Foxpro-nyn diagrammalary {igin
Microsoft Excel yada Windows-daky beyleki elektron
tablisalary ulanyp hem bolar.
Visual Foxpro-da kesisme tablisalar elektron tablisalara
menzesdir. Visual Foxpro maglumatlary awtomatiki yagdayda
toparlara bolyar we olaryn Ustlinde netije berydn hasaplamalary
gecirydr.  Topar hasaplamalardan sofira alynan maglumat
sortlanydr we kesisme tablisasyna oklanyir. Visual Foxpro
bilen islenilende ulanyjy bir we kop 6lgegli kesisme tablisalary
doredip bilyir. Yonekey birdlgegli kesisme tablisany doretmek
iicin adaty netijeli talaby ulanyp bolyar. Has g¢ylsyrymly
gorniisleri tigin  Visual Foxpro-da Cross-Tab Wizard atly
ussady ulanmaly bolyar.
Ilki bilen haysy gornilisli kesisme tablisa gerekdigini
kesgitlemeli.
Bir olcegli kesisme tablisasy
Bu tablisada bir faktor boyunca is gegirilyir.
Kesisme tablisanyn doredilsine {ins berelifi. Ahli maglumatlar
Customer tablisada yerlesyar.
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1. Data wkladkada Queries topary saylamaly we New
(Hossrit) diiwmesini basmaly .

Talabyn konstruktorynyn penjiresinde customer tablisany
goyun.

3. Fields wkladkada Selected fields yerde ccity meydan
boyunga COUNT (icdCustomer)komandany bermeli.
Group By we Order By wkladkalarda toparlary
kesgitlemeli we city meydan boyunga tertiplesdirmeli.

. Query -da Run Query komandany bermeli.

cntcust tablisada netijdni yatda goymaly, onun {i¢in Query
Designer -daky Query Destination diwméni ulanmaly.
Doredilen tablisada maglumatlar city (sdher) meydan
boyunca tertiplesdirilen bolyar we ony diagramma {i¢in
ulanyp bolyar.
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Surat: Birdlcegli kesisme tablisasy
Ikiolcegli kesisme tablisasy
Bu tablisada maglumatlar iki faktor boyunca toparlanyar.
Mysal tigin 1-nji suratdaky saleGoods tablisasyna tins bereli.
Bu tablisa talaplaryin esasynda  Customer, ordsaiem we
Ordsaied tablisalardan doredilen diyip hasap edilyar.
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SELECT Customer.cCity AS sédher, Ordsaied.icdGoods AS
onlimin kody;
SUM(Ordsaled.nQuant*Ordsaled.nUnitprice) AS jem;
FROM Sales(Customer INNER JOIN Sales!Ordsaiem;
INNER JOIN Sales!Ordsaied ;
ON Crdsalem. icdCrder = Ordsaled. icdOrder ;
ON Ccustemer. icdCustomer = Ordsalem. icdCustamer;
GROUP BY Customer.cCity, Ordsaled.icdGoods;
INTO TABLE sSaleGoods.dbf
Surat:salegoods tablisasy
Suratda Salegoods tablisanynn esasynda ikiOlgegli kesisme
tablisasy doredilen.

1.3y" Microoaft Visual FacPro
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T NULLT U NG|
+ NULL,  NULLL NULL.  Neil]
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=1 INUL Joe NULL femaMALY BI3(N
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- 1 .
Sl 2
isicsay
Query

Surat: Iki 6lgegli kesisme tablisasy

Ussadyn komegi bilen kesisme tablisalary doretmek

Visual Foxpro —da kesisme tablisalary doretmek tigin Cross-
Tab Wizard ulanyp bolyar. Emele gelen penjirede baslangy¢
maglumat saklayan tablisany aytmaly bolyar. Kesgitlenen
tablisanyn esasynda ussat netijeleyin saylawy geciryir, bu
yerde maglumatlar toparlanyar we jemlenyér. Sonra Visual
Foxpro vfpxtab.prg programmany c¢agyryar.
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1. File-da New komandany bermeli.

2. New —de doredilydn obyektiii tipini kesgitlemeli we
Query-da Wizard diiwméni basmaly.

3. Wizard Selection dialog penjireden Cross-Tab Wizard
ussady cagyrmaly. Yada Tools-de Wizard komandany
bermeli we Query saylamaly. Bu yagdayda  Wizard
Selection penjiresi agylyar.

4. saieGoods tablisany we gerekli meydanlary saylamaly we

Next basmaly.

i
550 1- Select Rslds =]

~ Which fiokds doyou want nyour croms-tob quany?
" Sslsct 3 datobess oc Fros Tatke: ke, nhuahu-ow-w.
and then sclsct the fakds you wart.

ko fickdx

Fioo =] =]
nuu | i Bl
Cancat | cusn |

Surat: Baslangyc tabhsanyn we meydanlarynyn saylanylsy
Indiki ddimde doredilydn kesisme tablisada verlesjek
meydanlaryn yerlesisini kesgitlemeli.

How do you wark 1o lay cut JOUl cross-tab queny?
Drag skt flokls to he croestab kcxkons,

[Toorn

Data

Hep cacat- | x| e b e

Surat:Setirilerin,siitiinlerii, meydanlaryn kesgitlenilsi.
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Sdher meydany Column -da, 6niim kody — Row -daa we
jemi - Data yere gegirmeli. Sofira dialog penjiresi asakdaky
gorniisde geler. Sonira Next basmaly.

I Cross-Tab Wiraed

| 5202 - Define Lrpaunt =]
How G0 you WAk 1 by cut 5O G105 1 queny?
Dragavatatia fkds 1o tha 6105 1k beatons.

Cancel I 4E-aJ Hee> | Fineth ]

Surat: Setirler, siitiinler, meydanlar kesgitlenenden soiira dialog penjiresi.

5. lindiki  penjirede Cross-Tab  Wizard opsiyalar
hodiirlenen.

Sum_jem

Count_umumy san

Average_orta baha

Max_in uly san

Min_in ki¢i san

1 Stop 3 Add Summary formaticn =l
3 i e ’ & 2 s TRt s
Deryou wart 13 03d @ subtotnl cchmn 1o yous dala™
* Selecttha ypo of to ou went e sach O ‘
Giun @ Smcfdes
I Lok € Number of calls contsining data
C fusrnge I Peceniage of e tabs ot
" Max T Ngre { [
C M e —

Surat: Netijeli siitiini we toparlamanyn tipini kesgitlemek.
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¥ Lross-1ab Wzard I B x|

| Step 4- Finh =]

You & 183CY to 1040 tha crogs-tab Guery

T o check vwous razuks, dik Proviow.,

Sakct an opticn and cick Freh

(% Save croes-tob quary

€ Savo and 1un cross-tab quary

[ Savs L0310 quary and modly n the. Ousry Desgrer

7 Disglayrdl i _ Praview

Hip | oo | ek | n=d | [Tk
Surat: Kesigme tablisanyn doredilsinin ahyrky tapkyry.
Finish diwmaini saylamaly. Ussat isini tamamlar we SQL
operatoryny acar. Onuil iicin Query menyusynda View SQL
komandany bermeli.

26. Visual Foxpro-nyi instalyasiyasy
Visual Foxpro-nyn instalyasyyasy ti¢in ulgama bolan talaplary
yasamak.
- operasion ulgam Windows 2000 Service Pack 2 we
ondan yokary Windows XP. Windows NT -de islemeyér.
- IBM kompyuter bilen baglansykly Pentium-dan pes
bolmaly dal.
- Sycanyn bolmagy.
- Operatiw hus 64 Mbayt-dan pes bolmaly dal.
- Gurnamak ii¢in 20 Mbayt bos hus bolmaly, 165 Mbayt
maksimal gurnamak tigin gerek.
- 256 renkli palitraly 800x600 monitor.
Visual Foxpro-nyn instalyasyyasynyn yzygiderligi.
llki bilen Windows ulgamyny goybermeli we dhli
programmalary yapmaly. Visual Foxpro CD-ROM-dan ya-da
tor arkaly gurnalyp bilinyér. Instalyasyyasyndan 6n antiwirus
programmany  Og¢iirmeli.  Gurnalmadan sofl  antiwirus
programma ise goyberlip bilner.
CD-ROM-dan Visual Foxpro-nyn instalyasyyasy.
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&

diskowoda gurnalyan kompakt diski salmaly.

Start menyuda Run komandany yerine yetirmeli.

X:\setup girizmeli, bu yerde x CD-ROM kesgitleyéin
simwol.

Enter diiwmesini basmaly.

instalyasyya programmasyndaky hereketleri yerine
yetirmeli.

Instalyasyyadan son  Visual Foxpro komponentleri
gosmak/yok etmek.
Instalyasyyasyndan son ulgamy optimizirldp bolyar. Onun {li¢in
indiki hereketleri yerine yetrimeli:

1.

2.

3.

4.

Windows-ynn Control Panel penjiresinde Add/Remove
Programms sonira Microsoft Visual Foxpro 8.0
saylamaly. Ondan son Add/Remove diiwmesine basmaly.
Microsoft  Visual Foxpro  Setup  diiwmesinde
Add/Remove diiwmesine basmaly.

Visual Foxpro 8.0 Custom dialog penjiresinde
komponentleri gosup, ayryp bolyar.

Continue diiwmesine basmaly.

Visual Foxpro 6nki wersiyalarynda programmany gurnamagyn
konfigurasyyasy Foxpro.ini faylda saklanyardy. Indi olar
Wndows-yn reestrinde saklanyar. Bu gurnamalaryn doly ugry:

H

Pro\8.

KEY_CURRENT_USER\Software\Microsoft\VisualFox
OXOptions.

Visual Foxpro-nyn ulgam menyusynyn elementlerinin atlary.
Ulgam menyu MSYSMENU ada eyedir.

File _MSM_FILE
Edit _MSM_EDIT
Data Session _MSM_VIEW
Format _MSM_TEXT
Tools _MSM_TOOLS
Program _MSM_PROG
Window _MSM_WINDO
Help _MSM_SYSTM
File menyusy _MFILE
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New...
Open...
Close
Close all
Save

1-nji boliji
Save As

Save As HTML...

Revert

2-nji boliji
Import
Export

3-nji boliiji
Page Setup
Print Preview
Pint...

Send

4-nji boliiji
Exit

Edit menyusy
Undo

Redo

1-nji boliji
Cut

Copy

Paste

Paste Special
Clear

2-nji boliji
Select all
3-nji boliiji
Find...
Replace...
Go To Line
4-nji boliiji

_MFI_NEW
_MFI_OPEN
_MFI_CLOSE
_MFI_CLALL
_MFI_SAVE
_MFI_SP100
_MFI_SAVAS

_MFI_SAVASHTML

_MFI_REVERT
_MFI_SP200
_MFI_IMPORT
_MFI_EXPORT
_MFI_SP300
_MFI_PGSET
_MFI_PREVU
_MFI_SYSPRINT
_MFI_SEND
_MFI_SP400
_MFI_QUIT
_MEDIT
_MED_UNDO
_MED_REDO
_MED_ SP100
_MED_CUT
_MED_COPY
_MED_PASTE
_MED_PSTLK
_MED_CLEAR
_MED_SP200
_MED_SLCTA
_MED_SP300
_MED_FIND
_MED_REPL
_MED_GOTO
_MED_SP400
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List members
Quick Info
5-nji boliji
Bookmarks
6-nji boliji
Insert object...
Object-

Links...

7-nji boliji
Properties

View menyusy
Toolbars...

Tools menyusy
Wizards>

1-nji boliji
Macros...

Class Browser
Component Gallery
Object Browser
Intellisense Manager
2-nji boliiji
Beautify...

Task List
Document View
3-nji boliji
Coverage Profiler
Breakpoints
Debugger

4-nji boliiji

Trace

Locals

Call stack

Output
Options...

_MED_LISTMEMBERS

_MED_QUICKINFO
_MED_SP500
_MED_BKMKS
_MED_SP600
_MED_INSOB
_MED_OBJ

_MED_LINK
_MED_SP700
_MED_PREF
_MVIEW
_MVI_TOOLB
_MTOOLS
_MTL_WZRDS
_MTL_SP100
_MTL_MACRO
_MTL_BROWSER
_MTL_GALLERY
_MTI_TASKLIST
_MTI_FOXCODE
_MTL_SP200
_MED_BEAUT
_MTI_TASKLIST
_MTI_DOCVIEW
_MTL_SP300
_MTL_COVERAGE
_MTL_BREAKPOINT
_MTL_DEBUGGER
_MTL_SP400
_MTL_TRACE
_MTL_LOCALS
_MTL_CALLSTACK
_MTL_DBGOUT
_MTL_OPTNS
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Wizards> _MWZRDS

Table _MWZ_TABLE
Query _MWZ_QUERY
Form _MWZ_FORM
Report _MWZ_REPRT
Label _MWZ_LABEL
Mail Merge _MWZ_MAIL
Privot Table _MWZ_PIVOT
Import _MWZ_IMPORT
Documenting _MWZ_FOXDOC
Upsizing _MWZ_UPSIZING
Application _MWZ_APPLICATION
Database _MWZ_DATABASE
Web Publishing _MWwWzZ_WEBPUBLISHIN
All Wizards MWz _ALL
Program menyusy _MPROG

Do... _MPR_DO

Cancel _MPR_CANCL
Resume _MPR_RESUM
Suspend _MPR_SUSPEND
1-nji boliji _MPR_SP100
Compile _MPR_COMPL
Window menyusy _MWINDOW
Cascade _MWI_CASCADE
Arrange All _MWI_ARRAN
1-nji boliji _MWI_SP100
Dockable _MWI_DOCKABLE
Hide _MWI_HIDE

2-nji boliji _MWI_SP200

Clear _MWI_CLEAR
Cycle _MWI_ROTAT
3-nji boliiji _MWI_SP300
Command Window _MWI_CMD

Data Session _MWI_VIEW
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Properties _MWI_PROPERTIES

Help menyusy _MSYSTEM
Microsoft Visual

Foxpro Help _MST_HPSCH
MSDN search _MST_MSDNS
1-nji boliji _MST_SP100
Technical Support _MST_TECHS
Visual Foxpro onthe Web _MST_VFPWEB
2-nji boliji _MST_SP200
About Microsoft

Visual Foxpro _MST_ABOUT
Diiwmelerin kodirowkasy.

Diiwme +shift +ctrl
F1 28 84 94
F2 -1 85 95
F3 -2 86 96
F4 -3 87 97
F5 -4 88 98
F6 -5 89 99
F7 -6 90 100
F8 -7 91 101
F9 -8 92 102
F10 -9 93 103
F11 133 135 137
F12 134 136 138
1 49 33 -

2 50 64 33
3 51 35 -

4 52 36 -

5 53 37 -

6 54 94 30
7 55 38 -

8 56 42 -
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Right 4 4 2 15

Left 19 19 26 15
Down 24 24 145 16
Esc 27 27 27 -
Enter 13 13 10 2
Backspace 127 127 127 1
Tab 9 15 148 16
SpaceBar 32 32 32 3

27. Visual Foxpro-nyn komandalary
Komanda
# DEFINE .. # UNDEF kompilyasiya prossesinde
konstantalary kesgitleyir yada ayyryar
#IF.. #ENDIF sert girizilyér
#INSERT generirlenen programma tekst girizar
#NAME icki prosedura hususy at kesgitlemége miimkingilik
beryar
$ bir simwol setiri bagga simwol setirinde bardygyny yada
yokdygyny kesgitleyar
? aillatmanyn bahasy ¢ykarylyar indiki setirden
?? anlatmanyn bahasy kursoryn duran yerinden ¢ykarylyar
??7? gbni printere ¢ykarylyar
! operasion ulgamyn komandalaryny we programmalaryny
yerine yetyar
@ ... BOX * gonibur¢lygy ¢yzyar
@... CLASS dolandyrma obyekti déredyar
@ ... CLEAR ekrany arrasalayar
@ ... BOX * koordinatalary berilen goniburglygy ¢yzyar
ACCEPT * simwol setiri ekrandan okayar
ACTIVATE MENU menyu setirini aktiwlesdiryar
ACTIVATE POPUP yiize ¢ykyan (BcmibiBaromiee) menyuny
aktiwlesdiryar
@ ..MENU * menyu gorkezilyar
@ ..PROMPT** kdmekei sozleri ¢ykaryar
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@...SAY™* formatlasdyrylan ¢ykysy printere ¢ykaryar
ACTIVATE SCREEN ihli yazgylary printere ekrana ¢ykaryar

ACTIVATE WINDOW penjirdni aktiwlesdirér
ADD CLASS kitaphana klas gosyar
ADD TABLE maglumat bazasyna bos tablisa gosyar

ALTER TABLE - SQL tablisanyn strukturasyny modfisirleyar
APPEND BLANK tablisanyn ahyryna bos yazgy gosyar
APPEND FROM tablisa basga fayldan yazgy gosyar

APPEND FROM array massiwden tablisa yazgy gegiryar
APPEND MEMO fayldan memo meydanyny dolduryar
APPEND PROCEDURES tekst faylyna prosedurany gosyar
BEGIN tranzaksiyanyn baslanyan yeri

BUILD EXE taslamadan yetiriji fayl doredyir (.EXE)

BUILD PROJECT taslamany doredyir we gurnayar
CALCULATE finans we statiki hasaplamalary yerine yetiryar
CANCEL komandalar togtadylyar

CD/CHDIR direktoriyany tiytgedyar

CHANGE yada EDIT tablisanyn meydanlaryny redaktirlemek
ticin hodiirleyar

CLEAR ALL fayllary yapyar , husy tytgeyin ululyklardan
bosadyar

CLEAR MACROS klawiaturanyn dhli makroslaryny ayyryar
CLEAR MEMORY husdan dhli tiytgeyéin ululyklary yok edyar
CLEAR MENUS husdan dhli menyulary ayyryar

CLEAR PROGRAM buferi arassalayar

CLEAR READ READ komandasyndan ¢gykmak

CLOSE DATABASES é&hli agyk maglumat bazalary yapyar
CLOSE FORMAT format faylyny yapyar

CLOSE MEMO memo-meydanyn redaktirlenyén penjiresini
yapyar

CLOSE PROCEDURE agyk prosedura faylyny yapyar
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CLOSE TABLES ihli acyk tablsalary yapyar

COMPILE programmany kompilirleyar

COUNT yazgylaryn sanyny kesgitleyar

CREATE tize tablisanyn fayl strukturasyny doredyéar
CREATE CLASS klaslaryn konstruktoryny agyar

CREATE COLOR SET reiiklerin toparyny doredyér

CREATE CONNECTION baglanysygy doredyar

CREATE CURSOR kursor déredyar

CREATE DATABASE maglumat bazany doredyar

CREATE FORM formanyn konstruktoryny agyar

CREATE QUERY talap ii¢in penjire agyar

CREATE REPORT hasabaty déredyar

CREATE SCREEN ekran formalary doredyér

CREATE TABLE SQL tablisany doredyar

CREATE TRIGGER triggeri doredyar

CREATE VIEW - SQL predstawleniye doredyir
DEACTIVATE MENU menyuny ekrandan ayyryér

DEFINE WINDOW penjire doredyar we onunl atributlaryny
kesgitleyar

DELETECONNECTION maglumat bazadan baglanysyklary
ayyryar

DELETE DATABASE maglumat bazany yok edyér

DELETE FILE fayly diskden yok edyér

DIMENSION bir ya-da iki 6l¢egli massiwi doredyér
DISPLAY tablisanyn yazgylaryny gorkezyar

DISPLAY DATABASE aktiw baza barada maglumaty
hodiirleyar

HELP komek penjiresini agyar

IMPORT tablisa bagga yerden maglumatlary geciyar

INDEX indeks faylyny doredyéir

INPUT simwol setirini girizdiryér

MODIFY CONNECTION baglanysyklary redaktirlemek ii¢in
penjirdni agyar

MODIFY DATABASE mazalary modifisirlemek {icin
penjirdni hodiirleyar
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MODIFY FILE tekst fayly géormek, redaktirlemek
MODIFY FORM formany doretmek yada liytgetmek

Hodiirlemini doretmek.

Iki tablisanynn  baglanysygy {¢in  hddiirleméni
doretmeklige seredelin. Ilki bilen dhli fayllary CLOSE ALL
komanda bilen yapmaly. Visual Foxpro-nyn miimkingiliklerini
ulanyp tablisalaryil arasyndaky gatnasygy gurnamaly. Onui
ticin esasy penjirede Window—>Data Session komandany
saylamaly we agylan penjirede open diiwmesini basmaly. Ilki
bilen tablisalary agmaly. Data Session tablisanyn Aliases
meydanynda tablisany saylamaly. Index Order Work Area
Properties tertip yazgysyndan indeksi saylamak igin
Properties diiwmesine basmaly. Data Session penjiresine
gaydyp barmak {ligin OK diiwmesine basmaly. Indi 1:1
gatnasygy gurnamaly. Birinji tablisany saylamaly we Relations
diiwmesine basmaly. Relations penjiresinde  arabaglansyk
¢yzygy peyda bolyar. Ikinji tablisa saylananda Expression
Builder penjiresi agylyar. 1:1 gatnasyk gurnalan we indiki
komanda generirlenyér:

SET RELATION TO meydan ady INTO
tablisanynt ady ADDITIVE

_J'l
Cumant secsion Defautft) w1
Lhagers Redatons
——t B
T Fayment - —Paynert

- -

Close

ﬁn.g\.)v

N[ Boperer ]

w A
- 4
\
oo

!

v |  mary

Work Area: 2 Recorgs 3
Surat: 1:1 Gatnasyk
I:N gatnasygy gurnamak {i¢in, Create One-To-Many
Relationship penjiresinde Establish 1-To-Many Relationship
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diaolgynn blokuny ulanmak tii¢in 1-To Many diiwmesine
basmaly. Seyle usul bilen SET SKIP TO komandasy
generirlenyédr we 1:N gatnasyk gurnalyar.

Cument sassion Delaai(1) v ’
Alases Rslatons
BT - [ 7o | N
t Pagment ~— Paynent |
I frowee J
l Open |
[_Coee ]
‘ Belations l
- 1 tomany poald

WorkAtex 2  Rscords: 3

Surat: 1:N gatnasyk.

Hodiirleme doretmek iigin  File menyunynn Save AS
komandasyny yerine yetirmeli we ony fayl gorniisinde
saklamaly. Bu yagdayda indiki komanda generirlenyar:

CREATE VIEW faylyii ady

Islendik wagt tablisalarynn arasyndaky gurnalan gatnasygy
dikeldip bolyar. Ony yerine yetirmek ii¢in .vue gifieltmeli fayly
agmaly. Onun {igcin File menyudan open komandany ya-da
komandalar penjiresinde SET VIEW TO faylyn ady.vue
komandany ulanmaly. SET VIEW ON komandasy acyk
hodiirleméni ekrana ¢ykaryar. Sonra indiki komandany yerne
yetirmeli:

BROWSE FIELDS tablisal.meydan, tablisa2.meydan

Penjirdni we hodiirleme faylyny yapmak {i¢in indiki komanda
ulanuylyar:

SET VIEW OFF
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Maglumatlaryi konwertirlenmesi, importirlenmesi we
eksportirlenmesi.

Tablisalara maglumatlary girizmekligini bir usuly olary
beyleki ulgamlardan import etmekdir. K4 yagdaylarda olar
ulgama standart ddl formatda gelyérler. Bir kodirleme
ulgamyndan beylekd gec¢irmeklige konwertirleme diyilyér.
Maglumatlary gaytadan isleyis ulgamlaryn koplisi esasy
formatly fayllary ulanyarlar. Konwertirleme meselesi Visual
Foxpro-nyn serisdeleri bilen Ordn ansat ¢oziilydr. Onuil {i¢in
kodirleme funksiyasy ulanylyar:

CHRTRAN(<kesgitlemeCl>, <kesgitlemeC2>,
<kesgitlemeC3>)
Mysal iigin MS-DOS reziminde doredilen tablisalary ya-da
programmalary ulanmak ii¢in, eger dosrus tiytgeyjisi MS-DOS-
da girizilen alfawitin dhli harplaryny, vfrus bolsa Visual
Foxpro-nyii harplaryny kesgitleyin bolsa konwertirldp bolyar.

Bagga tipli fayllardan berlenleri importirlemek tigin
APPEND FROM komandany ulanmaly, TYPE opsiyanyn
<faylyn tipi> parametri indiki bahalaryn birini kabul edyar:

- WK1,WK3WKSWR1,WRK - Lotus 1-2-3 ulgamyn
ulanyan fayllary {i¢in ;

- XLS, XL5, XL8 — Microsoft Excel-in fayllary tigin;

- DIF - (Data Interchange Format) VisiCalc-yn fayllary ii¢in;

- FW2 — Framework II faylynyn berlenleri ii¢in;

- MOD - Microsoft Multiplan berlenleri tigin;

- PDOX — Paradox tablisanyn berlenleri tigin;

- RPD — RapidFile-ifi berlenleri {igin;

- SDF — ASCII kodlaryn berlenleri {igin;

- SYLK - SYLK(Symbolic Link) berlenleri iigin;

- CVS - Comma Separated Value berlenler iigin.

Beyleki ulgamlardan berlenleriit import edilmegi asakdaky

komandanyn komegi bilen yerine yetirilyar:

IMPORT FROM <faylyn ady> [TYPE < faylyn tipi>]
Su maksatlar l¢in  hem Import Wizard ulanylyar.
Wizards—>Import komandasy berlenleri tekst fayldan, Excel,
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Multiplan, Lotus, Symphony, Paradox, Rapidfile elktron
tablisalaryndan importirldp bilyar. Import Wizard penjiresiniii
File Type tertip yazgysynda import edimeli berlenlerii
faylynyn tipini gorkezmeli. Import edilydn faylyn adyny we
onunn  saklanmaly yerini  gorkezmeli. Inidki &dimde
maglumatlar bazasyny, tablisanyn tipini saylamaly we tablisa
at bermeli. Meydanlar gurnalanda tdze tablisada meydanlaryn
tipini kesgitldp bolyar. Visual Foxpro-nyn tablisalaryndaky
maglumatlary eksportirlemek ii¢in indiki komanda ulanylyar:
EXPORT TO <tize faylyn ady> [<aragdkler>][FIELDS
<meydanlar>]

[FOR <sert>][WHILE <sert>][TYPE <faylyn tipi>]

Fayllaryn nusgasyny almak.

Berlenleri eksportirlemek iigin indiki komanda ulanylyp bilner:

COPY TO <tidze faylyn ady> [<aracdkler>][FIELDS
<meydanlar>]

[FOR  <sert>][WHILE  <sert>][TYPE  <faylyn
tipi>][WITH CDX]
Komanda agyk tablisanyn &hli ya-da gorkezilen yazgylaryny
taze fayla gociiryar. Adatca COPY TO <> komanda agyk
tablisanyil faylynyn diiziimini basga bir .dbf gineltmeli fayla
gocliryar. Mysal ti¢in f diskde new tablisany doretmek iigin we
olara f1, f2 we ondan sonky 99 yazgylaryin nusgasyny almak
iicin agakdaky programmany yerine yetirmeli:

USE old

COPY NEXT 100 TO F:\new FIELDS fl,f2 FOR fI>700

USE new

LIST

Eger tablisa maglumatlar bazasynda hasaba alnan bolsa, Visual
Foxpro bu tablisany bagga maglumatlar bazasyna gosmaklyga
rugsat etmeyar. Bu tablisalary tizeden doretmezlik {i¢in olary
multiindeks fayllary bilen go¢iirip bolyar:
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OPEN DATABASE old
USE TabOld
COPY TO TabNew WITH CDX

Eger COPY komanda .dbf gineltmesi bolmadyk fayllary
gbclirmek iicin ulanylyarn bolsa onda hokmany gineltmesini

gorkezmeli:
CLOSE ALL
COPY FILE first.prg TO second.prg

Ahli tablisalary basga diske gociirmeklik iigin DOS-yi
komandasyny ulanmaklyk amatly bolyar:

ICOPY *.dbf a:

ICOPY *.fpt a:

Tablisanyn diiziiminiii nusgasyny almak.

Old.dbf faylyn diiziimi bilen gabat gelydn new.dbf tize
faylyny doretmek {i¢in old.dbf faylyi diiziimini ZAP komanda
bilen arassalamaly.

USE old

COPY STRUCTURE TO new

USE new

DISPLAY STRUCTURE

Tablisalarda OLE obyektler.

Microsoft Word, Microsoft Excel, Microsoft Paint,
Adobe Photoshop, CoreIDRAW ulanyp doredilen grfika,
wideoklip, tekstler Visual Foxpro-nyn obyektleri bolup bilyar.
Ulanylyan obyektler barada maglumatlary saklamak iigin
General tipli tablisalaryin meydanlary bar. Onuil diiziimini
tablisalar bilen islenende goriip bolyar seyle hem formalary,
hasabatlary doredende ulanyp bolyar. General tipli bos meydan
tablisa goriilende ‘gen’ soézi bilen hodiirlenydr, ol hem
doldurlandan son ‘Gen’ séziine calsyrylyar. Asakdaky suratda
komandanyn yerine yetirilsi gorkezilen: BROWSE
FIELDS name, photo
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Surat: General tipli meydany saklayan tablisa.

Memo ya-da General tipli meydanlar bilen islemek ii¢in onun
istiinde sycanyn ¢ep diiwmesi bilen iki gezek basmaly. Bu
yagdayda degisli penjire agylyar. Ondan bagga-da bu
meydanlaryn ikisi hem tekst berlenleri saklamak {i¢in ulanylyp
bilner.

Obyekti gurmak we onui yerlesisi.

Visual Foxpro-nyn tablisalaryna girizilydn obyektler
OLE obyektler diyilydr. Girizmeklik prosessi obyektin
gurnalmagyny we onun yerlesisini kesgitleyar(OLE- Object
Linking Embedding). Obyekt yerlesdiilende ol priloZeniyada,
yagny prilozeniyanyn faylynyn icginde yerlesyar.  Visual
Foxpro-da dine onun salgysy verlesyir. Gurnalanda Visual
Foxpro-nyin  tablisasynda  yerlesen  obyektii  nusgasy
priloZeniyanyn ady bilen generirlenyér. Obyektin liytgedilmegi
Visual Foxpro-da goriinmeydr. General tipli meydana
programma yoly bilen fayldan OLE obyektin yazgysyny
gosmaklyk indiki komanda bilen yerine yetirilyar.

APPEND GENERAL <meydanyii ady> FROM <meydanyn
ady> [DATA <kesgitleme>] [LINK] [CLASS OLE <klassyn
ady>]

Adatga FROM soziinden son grafiki faylyn ady gelydr,
mysal iicin .bmp gifeltmeli bir fayl. DATA opsiyasy OLE
obyekte geg¢irilydn simwol setirini saklayar. LINK opsiyasy
gorkezilen fayldaky obyektin yerlesisini kesgitleydr. Grafiki
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obyektlere bu opsiya ulanylmayar. CLASS OLE opsiyasy OLE
klassy kesgitleyar. Bir tablisanyf her yazgysynda suratlaryny
saklamak {¢in tablisany acmaly, gorkezijini gerekli yazga
yerlesdirmeli we grafiki fayly goymaly.
USE tablisanyn ady
APPEND GENERAL photo FROM bmp\pLi.omp * grafiki
fayl yazgynyn General
* tipli meydanyna yiiklenyar.
Agyk tablisanyn &hli General meydanlarynyn diiziimini gérmek
ticin asakdaky komanda ulanylyar.
MODIFY GENERAL <meydanyn adyl > [ <
meydanyn ady2> .. ] [NOMODIFY]
[NOWAIT] [[WINDOW <penjirdnin
ady1>][IN][<penjirdnin ady2>|1H SCREEN]]
Bu yagdayda her bir obyekt 6z penjiresinde ya-da ekranda
cykarylyp bilner. Basga prilozeniyadaky obyektler agyk
General meydana menyunyn komandalary arkaly goylup
bilner:
- Edit->Paste;
- Edit->Paste Special,
- Edit->Insert Object.
Edit>Paste komandasy yerine yetirilmezinden o6n Cut
komandany ulanyp Windows Clipboard obyektifi nusgasyny
bufere yerlesdirin. Edit->Paste komandasy buferden obyekti
goyyar. Edit>Paste Special yerine yetirlende goymaklygyn
gorniislerini saylamaga miimkingilik beryan penjire acylyar:

Source  KAPapaAZa \Vek Pus\FosPra B\E dted\Fodl_06.00C ‘ OF

Al | Cancel ]

@ Paste S YR S—— |

Pchre (Ve ey |
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t Insests s coments of e ciptaant o your HAcwywent
COCUITANT 50 (AT 11y BCOWSTE i Uy
- MiczsaafOWoen Wil D clsplyea 8¢ @ oo

Rendl

|‘}|«}J I.r,m_ J

Surat: Paste Special komandanyn yerine yetirilsi.
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Paste. Edit>Paste komandasyna layyklykda buferden
obyekti goyyar. Goyulyan obyekti belgi gorniisinde
hodiirlemek miimkingiligi bar. Belgileriii gdrniisini Change
Icon diiwmesini saylap alyp bolyar.

Paste Link. Buferden obyekti yerlesdirmek. Bu yagdayda
General agyk meydanda obyektin salgysy saklanyar.
Gorkezilen  Paste  komandalary ~ Microsoft  Word
dokumentler ii¢cin ulanylyar. Obyektlerin basga tipleri seyle
hem tdze obyekti doretmek iicin menyunyn Edit—> Insert
Object komandasy ulanylyar. Bu komanda yerine
yetirlende  indiki  usullaryn  birini  saylamaklyga
miimkingilik beryédn penjire agylyar:

Create New. Prilozeniyalaryn birinde tdze obyekti
doretmek. Olaryn tertip yazgysy asakdaky suratda
gorkezilen.

Otyect Iyoe ‘ s T —— '

aCraata lew ke Pludoctap tacge 8
| Emmap mage Cancal
OO0 v Eim CoratDRAW 11 0 Exchange Graphic | romm——
enendile CosDRAAW 110 Graphic [ He
Meds Cx ——
1 MI0R Sequence .-
i Packags D Disglay A5 \con
rart Shop Fro imege v

Aot
Srumts 0 now A0S PROmOShoD Imags ol

ﬂ 10 yous duTRee
L

Surat:Téze obyekt doretmek iicin ulanylyan Insert Object penjiresi.
Create From File. OLE obyekti gosmaklyk. Fayly
kesgitlemek {i¢in onun adyny File meydanyna girizmeli ya-
da fayly saylamak {iigin Browse diiwmesini ulanmaly.
Paint-de doredilen suraty saklayan pli.bmp faylynyn obyekt
hokmiinde goyulsy asakdaky suratda gorkezilen.
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Surat: Object penjiresi.

Obyekti yerlesdirmek tigin Link-de baydajygy gurnamaly. Eger
su usul bilen Microsoft Word-ynn fayl.doc fayly yerlesdirlende
Edit->Links komandasyny verine yetirmeli, netijede Links
penjiresi agylyar. Onda obyektin tipi, fayl we onun ugry
saklanyar.

ouce  KAINCsodshon s
Fyea Muer Microsoft Sxcel

Jedate (5 Mgormalic © Morwal

Surat:Links penjiresi.
Penjirdnin diiwmelerini ulanyp belgilenen bolegi awtomatiki
tézeldp bolyar.
Obyekti redaktirlemek we yok etmek.
OLE obyekti redaktirlemek {icin menyunyn asakdaky
komandasyny ulanyp priloZzeniyany a¢maly:
- Edit->Picture BMPObject->Change- surat {i¢in;
- Edit->Document Object- Microsoft Word obyekt tigin.
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General acyk meydany arassalamak icin Edit->Clear
komandasy ulanylyar.

Drag-and-Drop — prilozeniyalaryn arasynda obyektleri
gecirmek.

OLE obyekti bir prilozeniyadan General agyk
meydanyna ge¢irip bolyar. Onun iicin iki priloZeniyalar hem
bir wagtda ekranda bolmaly. Drag-and-Drop iki komandanyn
yerine yetmeginde amala asyrylyar: Edit->Copy we
Edit->Paste.
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